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About this document

This document explains how to use the Preside Multiservice Data Manager 
Frame Relay service provisioning tool.

For more information about this document, see the following sections:

• “Who should read this document and why” (page 13)

• “What you need to know” (page 13)

• “How this document is organized” (page 13)

• “What’s new in this document” (page 14)

• “Text conventions” (page 14)

• “Related documents” (page 16)

Who should read this document and why
This guide is for personnel who create and manage Frame Relay PVC circuits 
for Passport, and for personnel responsible for VPN provisioning who need 
to connect a Frame Relay circuit to an IP VPN.

What you need to know
This document assumes that you have knowledge of Preside Multiservice 
Data Manager and an understanding of Passport.

How this document is organized
The information in this guide is organized as follows:

• “About Frame Relay service provisioning” (page 17) describes the tool 
and its advantages.
Preside MDM Service Provisioning for Frame Relay User Guide   15.1RSUP



14   About this document
• “Configuration and setup” (page 21) provides information on setup and 
system requirements.

• “Frame Relay service provisioning tool user interface” (page 29) 
describes the tool interface.

• “General procedures” (page 71) provides general procedures for using 
the Frame Relay service provisioning tool.

• “Frame Relay PVC provisioning” (page 115) describes how you can use 
the Frame Relay service provisioning tool to provision Frame Relay 
permanent virtual circuits between two or more network elements.

• “Frame Relay circuits with IP access for 2547 VPNs” (page 123) 
describes how you can use the tool to connect a frame relay circuit to an 
IP VPN for RFC 2547 VPNs

• “Frame Relay circuits with IP access for 2764 VPNs” (page 131) 
describes how you can use the tool to connect a frame relay circuit to an 
IP VPN for RFC 2764 VPNs 

• “Frame Relay Real Time Log Display tool” (page 139) describes how to 
use the Real Time Log Display tool to display and filter real time log 
messages generated by the Frame Relay service provisioning tool.

• “Historic Frame Relay Log File Display tool” (page 155)

What’s new in this document
Content for the Historic Frame Relay Log Display Tool (MB) was moved 
from 241-6001-303 Preside MDM Administrator Guide to this document. 

Text conventions
This document uses the following text conventions:

• nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or 
text that appears on your screen.

• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.
241-6001-603   15.1RSUP   
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• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.

• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.

• <general_term>

Words in angle brackets represent variables which are to be replaced with 
specific values.

• UPPERCASE, lowercase

Uppercase and lowercase letters that appear in UNIX commands and 
parameters must be matched exactly. The system matches upper and 
lowercase characters differently.

• |

This symbol separates items from which you may select one; for 
example, ON|OFF indicates that you may specify ON or OFF. If you do 
not make a choice, a default ON is assumed.

• ...

Three dots in a command indicate that the parameter may be repeated 
more than once in succession.

The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /).
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Related documents
See the following documents for related information:

• 241-6001-023 Preside MDM Configuration Management for Passport 
User Guide

• 241-6001-303 Preside MDM Administrator Guide

• 241-6001-310 Preside MDM Server Reference Guide

• 241-6001-400 Preside MDM Administration Database User Guide

• 241-6001-405 Preside MDM Administration Database Schema

• 241-6001-801 Preside MDM Overview

• NN10600-060 Nortel Networks Multiservice Switch 7400/15000/20000 
Component Reference

• NN10600-900 Nortel Networks Multiservice Switch 7400/15000/20000 
Frame Relay Technology Fundamentals

• NN10600-901 Nortel Networks Multiservice Switch 7400/15000/20000 
Frame Relay Configuration Management

• NN10600-800 Nortel Networks Multiservice Switch 7400/15000/20000 
IP Technology Fundamentals

• NN10600-905 Nortel Networks Multiservice Switch 7400/15000/20000 
Frame Relay UNI Job Aid
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Chapter 1
About Frame Relay service provisioning

For an introduction to the Preside Multiservice Data Manager (MDM) Frame 
Relay service provisioning tool, see the following sections:

• “Frame Relay service provisioning overview” (page 17)

Frame Relay service provisioning overview
The Frame Relay service provisioning tool lets you provision Frame Relay 
permanent virtual circuits (PVC) between two nodes. 

The Frame Relay service provisioning tool also lets you create Frame Relay 
circuits with IP Access for RFC 2764 and RFC 2547 VPNs. The types of 
access circuits are FrDte Backhaul and Direct (2764), and Optimized Local 
and Optimized Backhaul. These access circuits provide access from a 
customer site into an IP VPN. For all of these circuits, the access into the 
network elements on which the VPN Virtual Router resides, is through a 
Fruni or FrNni Dlci. All of these circuits support multiple IP CoS; 
provisioning of up to four circuits, one for each IP CoS level 0-3.

You can do your provisioning in one session and from a single user interface. 
Once you enter all the necessary provisioning data, you can activate the new 
view on the network element. 

The Frame Relay service provisioning tool is integrated with the circuit 
management application. The circuit management application treats a circuit 
as a single entity rather than a collection of individual components and 
attributes. Circuit information is stored in the Administration Database so that 
Preside MDM Service Provisioning for Frame Relay User Guide   15.1RSUP



18   Chapter 1 About Frame Relay service provisioning
you can retrieve it to view, modify, or delete it. You can also apply the changes 
or deletions to one ore more network elements, and the Administration 
Database.

The circuit is stored in the Administration Database after the view is 
successfully activated on the network element. 

Specific Traffic Management parameters are provisioned on the device but 
are not stored in the Administration Database.

In addition, the following circuit specific fields are stored only in the 
Administration Database:

• Traffic Management Profile name

• Circuit ID

• Customer

• Access point

• Site

For more details on the Frame Relay service provisioning tool, see

• “Configuration and setup” (page 21)

• “Frame Relay service provisioning tool user interface” (page 29)

• “Frame Relay PVC provisioning” (page 115)

• “Frame Relay circuits with IP access for 2764 VPNs” (page 131)

• “Frame Relay circuits with IP access for 2547 VPNs” (page 123)

For information on the Administration Database, see 241-6001-400 Preside 
MDM Administration Database User Guide.

Frame Relay service provisioning and the Administration 
Database

If the Preside Multiservice Data Manager (MDM) Administration Database 
is installed and you use the Frame Relay service provisioning tool to 
configure and activate on-switch data, the Administration Database is 
updated to maintain the current view of the network. If you do not activate the 
241-6001-603   15.1RSUP   
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configuration, the Administration Database is not updated because the current 
network view has not changed. The changes, however, will exist on the 
switch in either the edit or saved view. 
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Chapter 2
Configuration and setup

Before using the Frame Relay service provisioning tool, you need to ensure 
that the network element is configured for service provisioning, and you need 
to complete some or all of the following configuration tasks:

• “Network element configuration” (page 21)

• “Configuring the end-to-end server” (page 22)

• “Changing the server port number” (page 24)

• “Configuring and accessing the server host” (page 25)

• “Configuring the Real Time Log Display” (page 26)

Network element configuration
Before using the application, ensure that all the network elements to be 
provisioned are configured for Frame Relay up to the logical connection 
layer. The following is required:

• physical installation of cards, cabling, and other elements required to 
interconnect the nodes for service provisioning

• provisioning of cards, logical processors, software, ports, and Fruni or 
Frnni components on the nodes

For information on configuring network elements, refer to your 
documentation.
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Configuring the end-to-end server
You use the Server Administration tool to edit the entry for the Frame Relay 
end-to-end server. See 241-6001-310 Preside MDM Server Reference Guide.

Note: This is the same server used by the ATM and IP VPN service 
provisioning tools.

Procedure steps
1 While logged on as root, on the application main window, select System 

-> Administration -> Server Administration.

The Server Administration window opens.

2 From the Security menu, select Authorize.

The SVM Enter Authorization Password dialog box opens and prompts 
for a password.

3 If required, type a valid password and click OK.

4 From the Edit menu, select Edit-> New.

The Server Administration dialog box opens.

5 Add the server name in the Descriptive name field:

end-to-end server

6 Add the server startup command in the Startup command field:

/opt/MagellanNMS/bin/eteserver [-p <portno>]

7 If you do not want the server to restart automatically when the workstation 
is rebooted, click Automatic startup at reboot time.

8 Click Save and Start.

The data you entered is stored and the server is started.

9 From the File menu, select Refresh server list.

An updated server list is displayed, including the end-to-end server.

10 Click on the end-to-end server entry in the server list.

The Server Functions pop-up menu opens.

11 From the pop-up menu, select Start to start the end-to-end server.
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Variable values

Variable Value

<portno> The TCP port number for monitoring incoming requests. The 
default value is 6600. 

The port number must not be used by any other process.
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Changing the server port number
If your setup runs the end-to-end server on a port other than the default, you 
need to update the client resource file for the provisioning tool and 
reconfigure the server.

Procedure steps
1 While logged on as root, edit the Frame Relay provisioning resource file:

/opt/MagellanNMS/cfg/eteFrameRelayRes.cfg

2 To change the server port number from the default value of 6600, set the 
port parameter to the appropriate port number:

port = <portno>

3 Go to the Server Administration tool and edit the server port number 
option. See “Configuring the end-to-end server” (page 22).

4 Restart the end-to-end server.

Variable values

Variable Value

<portno> The TCP port number. The default value is 6600. 
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Configuring and accessing the server host
By default, the local host is the server host. If you are running the client on a 
different host than the server, you need to update the resource and host files.

Procedure steps
1 While logged on as root, edit the resource file:

/opt/MagellanNMS/cfg/eteFrameRelayRes.cfg

2 Set the host parameter:

host = <hostname>|<ipaddress>

3 While logged on as root, display the contents of the hosts file:

more /etc/hosts

4 Check that the file contains an entry with the IP address and host name 
of the end-to-end server.

5 If the entry is not listed, open an edit view of the resource file and add the 
IP address and host name on a new line:

<ipaddress> <hostname>

Variable values

Variable Value

<hostname> The host name of the end-to-end server.

<ipaddress> The IP address of the end-to-end server.
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Configuring the Real Time Log Display
Configure the Real Time Log Display if you wish to turn the log to file to “on” 
to write log messages to file, to set the maximum size of each log file, or to 
set the maximum number of log files created by the end-to-end Frame Relay 
tool for each session.

Procedure steps
Setting the log to file parameter to “on” lets you write log messages to a file. 
The default is off.

1 While logged on as root, edit the resource file:

/opt/MagellanNMS/cfg/eteFrameRelayRes.cfg

2 Set the parameter that specifies if log messages will be logged to a file.

LogToFile=<on/off>

3 Set the maximum log file size:

MaxKeptLogFileSize(MB)=<log_file_size>

4 Set the maximum number of log files to keep per user session:

MaxKeptLogFile=<maximum_log_file>

Variable values

Variable Value

<log_file_size> The maximum log file size before the log file is rolled over. If this 
value is less than or equal to zero, the default value, 11 Mbyte, will 
be used. When the log file reaches its maximum size, a rollover 
occurs. The old version of <log file name>.log.<nnn> is closed. The 
nnn extension is a three-digit log file counter. A new log file with the 
original name (<log file name>.log.<nnn+1>) is then used to 
continue the logging.

<maximum_log_file> The maximum number of log files that are generated in a session. 
If this value is less than or equal to zero, the default value will be 
used. The default value is 3. When the maximum number of log files 
is reached, the oldest file is deleted and a new one is created.

 (Sheet 1 of 2)
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<on> Specifies that you want to log the log messages to file. When 
LogToFile in the tool’s configuration file is set to “on”, all log records 
are written to a file, regardless of the log filtering criteria.

<off> Specifies that you do not want to log the log messages to file. Off is 
the default.

Variable (Continued) Value

 (Sheet 2 of 2)
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Chapter 3
Frame Relay service provisioning tool user 
interface

For a description of the Frame Relay service provisioning tool main window, 
see the following sections:

• “Main window overview” (page 30)

• “Menu bar” (page 31)

• “Provisioning interface for Frame Relay PVC circuits” (page 34)

• “Provisioning interface for Frame Relay IP VPN access circuits” 
(page 37)

• “Command panel” (page 47)

• “Dialog boxes for Frame Relay PVC and IP VPN Access provisioning” 
(page 48)

— “Set Default Authentication dialog box” (page 49)

— “Browse Service Interface dialog box” (page 49)

— “Browse Nodes dialog box” (page 50)

— “Traffic Management Parameters dialog box” (page 51)

— “Circuit retrieval dialog boxes” (page 54)

— “Create Circuit dialog box” (page 57)

— “Edit Circuit dialog box” (page 59)

— “Delete Circuit dialog box” (page 60)
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• “Dialog boxes for Frame Relay PVCs” (page 62)

— “Edit Backup Slave dialog box” (page 62)

— “Customer Search dialog box” (page 63)

• “Dialog boxes for Frame Relay IP VPN Access” (page 64)

— “Browse Customer dialog box” (page 64)

— “Site Search dialog box” (page 65)

— “Browse VRs/VRFs dialog box” (page 66)

— “Available DLCI dialog box” (page 66)

— “Browse FrDte/Remote Group dialog box” (page 68)

— “Browse lpDlciGroup dialog box” (page 68)

• “Using the keyboard commands” (page 69)

Main window overview
The Frame Relay service provisioning tool consists of a main window from 
which you do all your provisioning for FR PVC, and FR circuits with IP 
Access for the 2764 and 2547 VPNs. 

The user interface is dynamic and its contents change with the following 
circumstances:

• the type of circuit you select from the Circuit Type list; FR PVC or FR 
IP VPN access

• for FR IP VPN access circuits, the circuit configuration that you select:

— 2547 IP Opt Backhaul

— 2547 IP Opt Local

— 2764 IP Opt Backhaul

— 2764 Opt Local

— 2764 FrDte Backhaul

— 2764 FrDte Direct
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The window consists of the following elements:

• “Menu bar” (page 31)

• “Provisioning interface for Frame Relay PVC circuits” (page 34) or 
“Provisioning interface for Frame Relay IP VPN access circuits” 
(page 37)

• “Command panel” (page 47)

See also

• “General procedures” (page 71)

• “Frame Relay PVC provisioning” (page 115)

• “Frame Relay circuits with IP access for 2547 VPNs” (page 123)

• “Frame Relay circuits with IP access for 2764 VPNs” (page 131)

• “About Frame Relay service provisioning” (page 17)

• “Frame Relay Real Time Log Display tool” (page 139)

Menu bar
The menu bar consists of the following menus:

• “File” (page 31)

• “Edit” (page 32)

• “Options” (page 33)

• “Tools” (page 33)

• “View” (page 33)

• “Help” (page 34)

Note: You can use mnemonics or command accelerator to access menu 
options. For additional information, see “Using the keyboard 
commands” (page 69).

File
Note: The Edit Circuit and Delete Circuit commands are only available 
if the Preside Multiservice Data Manager (MDM) Administration 
Database is installed.
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The File menu contains the following commands:

• New Circuit deletes all information in the areas on the main window so 
you can start over with new connection information.

• Edit Circuit... opens the Edit Circuit retrieve dialog box. This dialog box 
lets you specify the retrieval criteria for the FR PVC or IP VPN access 
circuit to be edited. For FR PVC circuits, specify the circuit ID of the 
circuit to be retrieved from the Administration Database. If you know the 
circuit ID, you can either type it directly in the Circuit Id field, or you can 
use the Circuit Viewer to select the circuit. If you use Circuit Viewer to 
identify the circuit that you want to retrieve from the circuit list, the 
context is set. When the dialog box opens, the Circuit Id field contains 
the circuit ID which is currently in context. See “Circuit retrieval dialog 
boxes” (page 54) and “Editing a Frame Relay circuit” (page 85). For IP 
VPN access circuits, specify the Customer, Site, and Access point.

• Delete Circuit... opens the Delete Circuit circuit retrieval dialog box. 
This dialog box lets you specify the retrieval criteria for the FR PVC or 
IP VPN access circuit to be deleted. For FR PVC circuits, specify the 
circuit ID of the circuit to be retrieved from the Administration Database. 
You can either enter the Circuit ID directly in the Circuit Id field if you 
know it, or you can use the Circuit Viewer tool to select the circuit. If you 
use the Circuit Viewer tool to identify the circuit that you want to retrieve 
from the circuit list, the context is set so that when the dialog box opens, 
the Circuit Id field contains the circuit ID which is currently in context. 
See “Circuit retrieval dialog boxes” (page 54) and “Deleting a Frame 
Relay circuit” (page 89). For IP VPN access circuits, specify the 
Customer, Site, and Access point. 

• Exit closes the application window and exits Frame Relay service 
provisioning.

Edit
The Edit menu contains the following commands:

• Edit TM... opens the Traffic Management Parameters editing dialog 
box. See “Traffic Management Parameters dialog box” (page 51).

• Edit Backup Slave opens the Edit Backup Slave dialog box for Frame 
Relay PVC circuits. See “Edit Backup Slave dialog box” (page 62). This 
command is disabled for the Frame Relay IP VPN access circuit type.
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Options
The Options menu contains the following command:

• Set Default Authentication opens the Set Default Authentication dialog 
box to set the user ID and password for authenticating access to a node.

Tools
The Tools menu contains the following commands.

• Nodal Provisioning launches the Nodal Provisioning tool. When you 
select this command the Preside Multiservice Data Manager (MDM) 
splash screen appears, followed by the Nodal Provisioning Device 
Selection dialog. For a description of Nodal Provisioning and procedures 
to use it, see 241-6001-610 Preside MDM Nodal Provisioning User 
Guide.

Note: After you launch Nodal Provisioning, you can perform nodal 
provisioning tasks. However, before you can apply the Frame Relay 
service, you need to activate the nodal provisioning session and then 
close Nodal Provisioning. If you try to apply the service before closing 
the Nodal Provisioning session, an error message appears indicating that 
a provisioning session cannot be started on the switch. The error message 
does not inform you that this error is generated because the Nodal 
Provisioning tool is holding the provisioning session.

• Circuit Viewer launches the Circuit Viewer tool. For a description of the 
Circuit Viewer tool and procedures to use it, see 241-6001-011 Preside 
MDM Fault Management User Guide.

• MDM Database Administration launches the Circuit Database 
Administration tool. For a description of the Circuit Database 
Administration tool and the procedures to use it, see 241-6001-400 
Preside MDM Administration Database User Guide.

View
The View menu contains the following command:

• Show Messages launches the Real Time Log Display. See “Frame Relay 
Real Time Log Display tool” (page 139).
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Help
The Help menu contains the following command:

• Help on Window displays help information for the Service Provisioning 
- Frame Relay window.

Provisioning interface for Frame Relay PVC circuits
The main section of the Service Provisioning - Frame Relay main window 
for PVC circuit types contains the following areas:

• “Circuit Type panel” (page 34)

• “Circuit Properties panel” (page 34)

• “PVC Node Properties panel” (page 36)

• “Command panel” (page 47)

Information on valid data entries for the fields in the provisioning panels are 
provided through tool tips. 

Circuit Type panel
The Circuit Type list identifies the circuit types that you can provision with 
the Frame Relay service provisioning tool. This list contains the FR PVC and 
FR IP VPN Access circuit types. For provisioning a Frame Relay circuit to 
connect to an IP VPN, you need to select the FR IP VPN Access circuit type.

For provisioning a Frame Relay PVC, you would select the FR PVC circuit 
type. See “Frame Relay PVC provisioning” (page 115) for provisioning 
procedures.

Circuit Properties panel
Use the Circuit Properties panel to make selections which affect the entire 
Frame Relay PVC connection. The contents of this panel depends on whether 
the Preside Multiservice Data Manager (MDM) Administration Database is 
installed. It may have the following fields and buttons:

Note: The Circuit Id and Customer fields appear in the user interface 
only if you have installed the Administration Database. These fields are 
mandatory and activation does not proceed if these fields are not filled in.
241-6001-603   15.1RSUP   



Chapter 3 Frame Relay service provisioning tool user interface   35
• If the Administration Database is installed, the Circuit Id field lets you 
enter a meaningful name for the permanent virtual circuit. The Circuit ID 
lets circuit management applications more easily find and identify 
circuits based on meaningful customer names. The circuit ID provides a 
method for operators to link subscriber information with the circuit, 
providing a unique and meaningful name to assist in the management of 
the circuit. A suggested format is “Customer Name” plus a unique 
identifier (for example: BigCustomer00000023). This format provides 
visibility of the end subscriber, while still allowing the circuit to be 
uniquely identified.

The Circuit ID is a 128-byte text field with no restriction or uniqueness 
checking on the node. If the Use Circuit Id is checked, the circuit ID is 
stored in the CorrelationTag attribute.

Note: If you duplicate a circuit ID, both circuits are stored in the 
Administration Database with the same circuit ID.

• The Correlation Tag field is used to set the value of the correlationTag 
attribute to the entered value for each PVC component in the connection.

• If the Administration Database is installed, the Customer field is a 
mandatory field that lets you specify the customer of the circuit. Type an 
entry or click the browse button [...] to open the customer search dialog 
(see “Browsing customers” (page 80). If you do not specify a customer, 
Frame Relay service provisioning assigns the default customer and the 
customer name is set to default in the Administration Database. 

• The Use Circuit Id check box optionally lets you set the correlationTag 
equal to the circuit ID. When you check Use Circuit Id, the Correlation 
Tag field is automatically filled with the same value as the circuit ID. The 
Correlation Tag field is in read-only mode. The maximum length of the 
correlationTag attribute is 32 characters. If you enter a circuit ID with 
more than 32 characters, and you have checked Use Circuit Id, only the 
first 32 characters are provisioned on the device as the correlationTag. 
However, the Administration Database stores the entire circuit ID that 
you entered.

• The TM Profile field lets you select a traffic management profile, also 
known as quality of service (QOS) profile, for the Frame Relay PVC 
connection. The file name of TM profiles that are not saved to disk have 
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an asterisk (*) at the end of its name to indicate that the TM Profile has 
been changed but not saved. Profiles that are modified but not saved are 
stored in the Administration Database as “Custom”

• The Edit TM... button opens a dialog box from which you can create a 
new traffic management template or edit an existing one. For more 
information, see “Creating a new Traffic Management profile” 
(page 93). See also the figure “Traffic Management Parameters dialog 
box” (page 51).

PVC Node Properties panel
The Node Properties panel for Frame Relay PVC circuits contains the 
following subpanels:

• “Master panel” (page 36)

• “Slave panel” (page 37)

Master panel
Use the Master Node area to configure the master endpoint of the Frame 
Relay PVC connection. It has the following fields and buttons:

• The Node Name field lets you specify the name of the network element 
for the Frame Relay Access Node. You can select a network element 
from the drop down list, or as you type the name into the field, the first 
item in the drop down list that matches the text is automatically selected. 
Pressing the Enter key sets the selection.

• The browse button (...) opens the Browse Nodes dialog box; see 
“Browse Nodes dialog box” (page 50) and “Browsing nodes” (page 83).

• The Use Defaults check box lets you specify whether to use the default 
user ID and password to provision the selected node. If this check box is 
deselected, the User Id and Password fields are enabled and you need to 
enter a user ID and password.

• The Type list lets you select a Frame Relay user-to-network interface 
(Fruni) or a Frame Relay network-to-network interface (Frnni) as the end 
point.

• The Fruni Instance | Frnni Instance list lets you indicate how you want 
to identify the endpoint: by Fruni|Frnni instance, data network address 
(DNA) value, or Port Interface. 
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Note: The type of instance depends on the type chosen in the Type field.

• The browse button [...] opens a Browse dialog box that lets you search 
for and select a Frame Relay user-to-network interface|network-to-
network interface and/or a data link connection identifier (DLCI) from a 
list of available interfaces and identifiers on a selected node. See 
“Browse Service Interface dialog box” (page 49) and “Browsing service 
interfaces” (page 84).

• The New DLCI field lets you specify an instance number for the data 
link connection identifier (DLCI).

• The Get Next button automatically fills in the next unassigned DLCI.

Slave panel
Use the Slave panel to configure the endpoint of the Frame Relay permanent 
virtual circuit (PVC) connection. The fields are similar to those in the Master 
Node area but with the addition of the following items:

• An Edit Backup... button to configure backup slave endpoints for the 
PVC connection. For more information, see “Backup slaves 
configuration” (page 119).

• A Use as backup check box to configure the slave node as a permanent 
backup slave. This check box is available only if backups exist. 
Otherwise, the check box is unavailable and the slave node is configured 
as a permanent slave with backups. 

Provisioning interface for Frame Relay IP VPN access 
circuits

The provisioning interface for Frame Relay IP VPN access circuits contain 
the following panels:

• “Circuit Type panel” (page 38)

• “Circuit Properties panel” (page 34) 

• “IP Service Node Properties panel” (page 39)

• “Frame Relay Access Node Properties panel” (page 44)

• “End Points panel” (page 46)
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Information about valid data entries for the fields in the provisioning panels 
are provided through tool tips. 

Circuit Type panel
Use the Circuit Type panel to make selections which affect the entire Frame 
Relay IP VPN connection. The panel contains the following items:

• Circuit Type list identifies the circuit types that you can provision with 
the Frame Relay service provisioning tool. This list contains the FR PVC 
and FR IP VPN Access circuit types. For provisioning a Frame Relay 
circuit to connect to an IP VPN, you need to select the FR IP VPN Access 
circuit type.

• Circuit Configuration list appears in the Circuit Type panel only when 
you select the FR IP VPN circuit type. It contains the access scenarios:

— 2547 IP Opt Backhaul

— 2547 IP Opt Local

— 2764 IP Opt Backhaul

— 2764 IP Opt Local (only in PCR 5.1)

— 2764 FrDte Backhaul

— 2764 FrDte Direct

Circuit Properties panel
The circuit properties panel specifies general circuit data. This panel appears 
only if the Preside Multiservice Data Manager (MDM) Administration 
Database is installed. This panel contains the following items

• The Customer field is a mandatory field that lets you specify the 
customer of the circuit. If you do not specify a customer, the tool prompts 
you to use the default customer, and the customer name is set to default 
in the Administration Database. You can search for and select customers 
from the Administration Database by using the associated drop-down list 
or browse button [...] to the right of the Customer field. The drop-down 
list displays available customers from which you can make a selection. 
The browse dialogs display the customer list and associated VRs or 
VRFs, depending on the circuit type. For details about the Browse 
Customer dialog boxes, see “Browse Customer dialog box” (page 64). 
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• The Site field lets you specify a Customer Site. A Site is where IP access 
is implemented and represents a collection of IP Access Points. The Site 
must be unique among all Sites belonging to the Customer. You can 
create a new Site by typing a Site name in the Site field. Alternatively, 
you can search for and select from existing Sites in the Administration 
Database by clicking the browse button [...] to the right of the Site field. 
For additional information, see “Site Search dialog box” (page 65) and 
“Browsing Sites” (page 106)

• Access Point field lets you specify the IP Access Point. The access point 
is the gateway from the Customer Site into an IP VPN. It must be unique 
within the Site.

• Site Type field indicates whether the site is an extranet or intranet. For 
existing circuits, this field is set automatically—2764 circuits are always 
intranet and 2547 circuits can be either intranet or extranet. When you 
create a new site, the service provisioning tool sets the field as intranet 
when all the route targets under the specified VRF are owned by the same 
customer. Otherwise, the site type is extranet.

IP Service Node Properties panel
This panel lets you enter the IP access information. This information is 
needed to link the Frame Relay circuit to a VPN. The IP Service Node is 
where the VR, FrDte, Media, Interface or Logical Interface, and IP Service 
(master) FrUni/FrNni are located for Fr IP VPN Access circuits. 

The following items in the IP Service Node Properties panel are common to 
all circuit configurations:

• Node Name field lets you specify the name of the network element for 
the Frame Relay Access Node. You can select a node from the dropdown 
list, or as you type the name of the node into the field, the first item in the 
drop down list that matches the text is automatically selected. Pressing 
the Enter key sets the selection.

• Browse nodes button [...] opens the Browse Nodes dialog box which 
search for and select a node. See “Browse Nodes dialog box” (page 50) 
and “Browsing nodes” (page 83).
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• Use Defaults check box is selected by default. You can override the 
default user ID and password by deselecting this button. When Use 
Defaults is deselected, the User ID and Password fields become enabled 
and need to be filled in to connect to the node.

• User Id field is enabled only if the Use Defaults check box is deselected. 
You can enter a User ID for the node.

• Password field is enabled only if the Use Defaults check box is 
deselected. You can enter a password for the node.

The remaining contents of the IP Service Node panel are dynamic. That is, 
the contents change with the circuit configuration that you select. For the 
description of the contents of the panel for each circuit configuration, see the 
table “IP Service Node Properties panel contents” (page 40).

Table 1
IP Service Node Properties panel contents 

IP VPN Panel content Description

2764 FrDte circuits 
(Backhaul and Direct)

VR field The target Virtual Router instance.

VR browse button 
[...]

Opens the Browse VR dialog box to let you search 
for available VRs on the IP Service Node.

 (Sheet 1 of 5)
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Logical Interface 
field

The logical interface instance in the form 
<ip_address>/<mask>, where ip_address is in the 
form n.n.n.n where n is in the range 0 to 255, and 
mask is an integer from 0..32. This integer denotes 
the number of leading consecutive 1’s in the mask. 
The Logical Interface is the access point to the 
VPN circuit and is created when you apply the 
provisioning. It will be created under a new or 
existing ProtocolPort, depending if the Media is 
new or not. If the Media exists, the ProtocolPort will 
be associated to it. The VR entered in this panel 
must have the ProtocolPort associated with the 
existing media, or an error will occur.

If the Media is new, a new ProtocolPort and IPPort 
is created under the VR.

FrDte field The instance of the target FrDte in the 2764 circuit 
configuration. A StaticDlci is provisioned under the 
FrDte when you apply the provisioning. The media 
for these circuit configurations, the remoteGroup, 
is created under the FrDte.

FrDte browse 
button [...]

Opens the Browse FrDte/Remote Group dialog 
box which lets you browse the IP Service Node for 
FrDte instances only, or for both FrDte and 
remoteGroup instances.

Remote Group field The instance of the media - remoteGroup.

2764 IP Opt Local 
circuit 

VR field The Virtual Router instance.

VR browse button 
[...]

Opens the Browse VR dialog box to let you search 
for available VRs on the IP Service Node.

Table 1 (Continued)
IP Service Node Properties panel contents 

IP VPN Panel content Description
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Logical Interface 
field

The logical interface instance in the form 
<ip_address>/<mask>, where ip_address is in the 
form n.n.n.n where n is in the range 0 to 255, and 
mask is an integer from 0..32. This integer denotes 
the number of leading consecutive 1’s in the mask. 
The Logical Interface is the access point to the 
VPN circuit and is created when you apply the 
provisioning. It will be created under a new or 
existing ProtocolPort, depending if the Media is 
new or not. If the Media exists, the ProtocolPort will 
be associated to it. The VR entered in this panel 
must have the ProtocolPort associated with the 
existing media, or an error will occur.

If the Media is new, a new ProtocolPort and IPPort 
is created under the VR.

lpDlciGroup field The instance of media - lpDlciGroup.

lpDlciGroup browse 
button [...]

Opens a browse dialog box which lets you search 
for lpDlciGroup instances on the IP Service Node 
and select an instance.

2764 IP Opt Backhaul 
circuit

VR field The target Virtual Router instance.

VR browse button 
[...]

Opens the Browse VR dialog box to let you search 
for available VRs on the IP Service Node.

Table 1 (Continued)
IP Service Node Properties panel contents 

IP VPN Panel content Description
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2764 IP Opt Backhaul 
circuit (continued)

Logical Interface 
field

The logical interface instance in the form 
<ip_address>/<mask>, where ip_address is in the 
form n.n.n.n where n is in the range 0 to 255, and 
mask is an integer from 0..32. This integer denotes 
the number of leading consecutive 1’s in the mask. 
The Logical Interface is the access point to the 
VPN circuit and is created when you apply the 
provisioning. It will be created under a new or 
existing ProtocolPort, depending if the Media is 
new or not. If the Media exists, the ProtocolPort will 
be associated to it. The VR entered in this panel 
must have the ProtocolPort associated with the 
existing media, or an error will occur.

If the Media is new, a new ProtocolPort and IPPort 
is created under the VR.

lpDlciGroup field The instance of media - lpDlciGroup.

Service Type field For optimized backhaul circuits, FrUni is the only 
service type.

FrUni Instance You can enter an instance value in this field, or use 
the associated browse button.

Fruni Instance 
browse button [...]

Opens a Browse Service Interface dialog box that 
lists FrUni instances that have other interfaces 
associated with them (by the VFramer 
subcomponent). Select a FrUni instance from the 
list to populate the FrUni Instance field on the 
service provisioning window.

2547 IP Opt Local

Vrf The target Virtual Routing Function instance.

Vrf browse button 
[...]

Opens the VR browse dialog box which lets you 
browse for Vrf instances on the IP Service Node.

Table 1 (Continued)
IP Service Node Properties panel contents 

IP VPN Panel content Description
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Frame Relay Access Node Properties panel
The Frame Relay Access Node Properties panel is dynamic and differs with 
each configuration of the FR IP VPN Access circuit type. 

Interface The interface instance in the form <ip_address>/
<mask>, where ip_address is in the form n.n.n.n 
where n is in the range 0 to 255, and mask is an 
integer from 0..32. This integer denotes the 
number of leading consecutive 1’s in the mask. 

The Interface is a direct subcomponent of the VRF, 
and is created when you apply the provisioning.

2547 IP Opt Backhaul

Vrf The target Virtual Routing Function instance.

Vrf browse button 
[...]

Opens the VR browse dialog box which lets you 
search for Vrf instances on the IP Service Node.

Interface The interface instance in the form <ip_address>/
<mask>, where ip_address is in the form n.n.n.n 
where n is in the range 0 to 255, and mask is an 
integer from 0...32. This integer denotes the 
number of leading consecutive 1’s in the mask.

Service Type field For optimized backhaul circuits, FrUni is the only 
service type.

FrUni Instance You can enter an instance value in this field, or use 
the associated browse button.

Fruni Instance 
browse button [...]

Opens a Browse Service Interface dialog box that 
lists FrUni instances that have other interfaces 
associated with them (by the VFramer 
subcomponent). Select a FrUni instance from the 
list to populate the FrUni Instance field on the 
service provisioning window.

Table 1 (Continued)
IP Service Node Properties panel contents 

IP VPN Panel content Description
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For local and direct circuit configurations, only the Service Type list, 
FrUni|FrNni Instance list and browse button [...] are enabled. The following 
FR IP VPN Access node information is disabled:

• Node Name field

• Browse nodes button [...]

• Use Defaults check box

• User Id and Password fields

For backhaul circuit configurations all the fields and buttons are enabled:

• You specify the name of the node for the Frame Relay Access Node in 
the Node Name field. You can select a node from the dropdown list, or 
as you type the name of the node into the field, the first item in the drop 
down list that matches the text is automatically selected. Pressing the 
Enter key sets the selection. Alternatively, you can use the browse button.

• The browse button [...] opens the Browse Service Interface dialog box 
which displays the list of those FrUni/FrNnis that have no interfaces 
associated with them (no VFramer subcomponents). See “Browse 
Service Interface dialog box” (page 49) and “Browsing service 
interfaces” (page 84).

• The Use Defaults check box lets you specify whether to use the default 
user ID and password to provision the selected node. If this check box is 
deselected, the User Id and Password fields are enabled and you need to 
enter a user ID and password.

• The Type list lets you select a Frame Relay user-to-network interface 
(Fruni) or a Frame Relay network-to-network interface (Frnni) as the end 
point.

• The Fruni Instance | Frnni Instance list lets you indicate how you want 
to identify the endpoint: by Fruni|Frnni instance, data network address 
(DNA) value, or Port Interface. 

Note: The type of instance depends on the type chosen in the Type field.

• The browse button [...] opens a Browse dialog box that lets you search 
for and select a Frame Relay user-to-network interface|network-to-
network interface and/or a data link connection identifier (DLCI) from a 
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list of available interfaces and identifiers on a selected node. See 
“Browse Service Interface dialog box” (page 49) and “Browsing service 
interfaces” (page 84).

End Points panel
To accommodate multi Class of Service (CoS) circuits, the data for each end 
of the Frame Relay IP VPN Access circuit are entered in tabular format in the 
End Points table. The contents of a cell can be updated by right-clicking on it 
to open a pop-up menu and selecting a menu item, or by editing the cell 
directly. When you enter data into a cell of a row, you are provisioning the 
circuit within that CoS. In addition to the end point information, you can 
select a different correlation tag and a Traffic Management (TM) profile for 
each CoS.

The End Points table contains the following headings for FrDte Backhaul and 
Direct circuits:

• CoS Index

• IP Service DLCI

• FR Access DLCI

• Correlation Tag

• TM Profile

Optimized Backhaul and Local Circuits, the End Points table also contains 
the Media DLCI column. However, Optimized Local circuits do not contain 
the IP Service DLCI column.

The following pop-up menu commands are available from the various 
columns:

• The Clear Row pop-up menu item is available only from the CoS Index 
column. Selecting Clear Row blanks out all the fields in the row.

• The Edit TM... pop-up menu item is available from the TM Profile 
column. Selecting this item opens the Frame Relay Traffic Management 
Profile Editor. For more information on the traffic management editor, 
“Traffic Management Parameters dialog box” (page 51), and “Traffic 
Management procedures” (page 92).
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• A drop down list of available TM Profiles is available from each cell in 
the TM Profile column. To select a profile, left-click on the cell, then 
select the profile from the list.

• The Browse DLCI pop-up menu command is available from the FR 
Access DLCI, IP Service DLCI and Media DLCI columns. The Browse 
DLCI pop-up menu item opens a browse dialog box. For FR Access 
DLCIs, the values returned depend on the circuit configuration. For more 
information on the Available DLCI dialog box, see “Available DLCI 
dialog box” (page 66) and the table “Circuit configurations and values 
returned by the Browse DLCI pop-up menu item” (page 67) for a 
description of the Browse DLCI pop-up menu associated with various 
circuit configurations.

Command panel 
The buttons displayed in the command panel depend on whether you are 
performing a create, edit, or delete operation:

• Circuit creation

During a circuit creation, only the Apply button is displayed. When you 
click Apply, the Frame Relay service provisioning tool checks if you 
have entered all required configuration information. If mandatory 
configuration information is missing, a message dialog box opens and 
informs you what data is missing. 

If you have entered all required data, the Apply button opens the Create 
Circuit dialog box so that you can apply the configuration that you have 
set up. You can specify the apply actions in the Create Circuit dialog 
box and click OK to begin provisioning the configured nodes in the 
Frame Relay PVC connection. See “Create Circuit dialog box” 
(page 57).

The circuit information is stored in the Administration Database after the 
view is successfully activated on the node. You can retrieve, view, 
modify, or delete this circuit.

• Circuit modifications

During an edit circuit action, the following buttons are displayed in the 
Command panel:
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— Validate validates the circuit configuration data that you have 
retrieved from the Administration Database against the current node 
configuration data. If the data matches, the applicable fields are set 
to read-write and the Apply button is enabled.

— Apply is disabled until the circuit has been successfully validated. If 
mandatory data is missing, a message dialog box opens listing the 
missing configuration data. If any discrepancies exist in the circuit, 
they need to be resolved before the edit operation can proceed.

The Apply button opens the Edit Circuit dialog box, once you have 
entered all the required configuration data. The Edit Circuit dialog 
lets you specify how to apply the configuration. For additional 
information, see “Edit Circuit dialog box” (page 59) and “Editing a 
Frame Relay circuit” (page 85).

— Reset resets all configuration data fields to the values currently 
stored in the Administration Database, replacing any editing 
changes that you have made, but not yet applied. The Reset button 
is disabled until the circuit has been successfully validated.

• Circuit deletion

During an delete circuit action, the following button is displayed in the 
Command panel:

— Delete... opens the Delete Circuit dialog. This dialog lets you 
specify how to apply the circuit deletion. For additional information, 
see “Delete Circuit dialog box” (page 60), and “Deleting a Frame 
Relay circuit” (page 89).

Dialog boxes for Frame Relay PVC and IP VPN Access 
provisioning

For a description of the dialog boxes common to both Frame Relay PVC and 
Frame Relay IP VPN Access provisioning, see the following sections:

• “Set Default Authentication dialog box” (page 49)

• “Browse Service Interface dialog box” (page 49)

• “Browse Nodes dialog box” (page 50)

• “Traffic Management Parameters dialog box” (page 51)
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• “Circuit retrieval dialog boxes” (page 54)

• “Create Circuit dialog box” (page 57)

• “Edit Circuit dialog box” (page 59)

• “Delete Circuit dialog box” (page 60)

Set Default Authentication dialog box
The Set Default Authentication dialog box lets you set the default user ID and 
password to login to the network element. This dialog box opens when you 
select Options -> Set Default Login from the menu bar in the Service 
Provisioning - Frame Relay window. This dialog box also opens the first time 
you make provisioning changes that require a connection to the network 
element, and you have not yet set the default user ID and password.

Browse Service Interface dialog box
This dialog box lets you select a Frame Relay user-to-network interface 
(Fruni), Frame Relay network-to-network interface (Frnni) and/or a data link 
connection identifier from a list. For the procedure, see “Browsing service 
interfaces” (page 84).

The Browse Service Interface dialog box that opens differs slightly 
depending on the circuit type and whether the circuit has a backhaul 
configuration or not. In a backhaul configuration, the FrUni instance requires 
a vFramer. In these circumstances, an additional entry for port interfaces 
displays in the dialog box. 

The Browse Service Interface dialog box opens when you click the browse 
button [...] to the right of the Fruni|Frnni field in the following locations:

•  in the Master Node panel or the Slave Node panel of a Frame Relay PVC 
circuit

• in the Frame Relay Access Node Properties panel of a Frame Relay IP 
VPN Access circuit

• in the IP Service Node Properties panel for the following Frame Relay IP 
VPN Access circuit configurations:

— 2764 IP Opt Backhaul

— 2547 IP Opt Backhaul
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The dialog box contains the following elements:

• Browse dialog table contains the following columns:

— The Fruni | Frnni Instance column displays all Frame Relay user-
to-network interface (Fruni) or Frame Relay network-to-network 
interface (Frnni) instances according to your selection.

— The DNA Value column displays the data network address (DNA) 
value for the corresponding Fruni/Frnni instance in the first column.

— The Port Interface column displays the port interface for the 
corresponding Fruni/Frnni instance in the first column. This column 
displays only if the search is for a backhaul configuration where a 
FrUni requires a vFramer. Otherwise, this column does not display

• The Show button, available for FR PVC searches only, populates the 
Available DLCIs area with the existing data link connection identifiers 
(DLCI) for the selected Frame Relay user-to-network interface (Fruni) or 
Frame Relay network-to-network interface (Frnni).

• Action buttons

— OK copies the selected node into the Fruni | Frnni Instance field 
in the main window. The Browse dialog closes.

— Cancel dismisses the dialog. The Fruni | Frnni Instance field is 
unchanged.

— Help accesses the online help information for the dialog.

Browse Nodes dialog box
The Browse Nodes dialog opens when you click Browse to the right of the 
Node Name field in the Master Node or Slave Node area. The Browse 
Nodes dialog lets you select from a list of nodes available from the Host 
Group Directory Service (HGDS) server.

The Browse Nodes dialog consists of the following elements:

• Search criteria panel. This panel has the following fields

— Device Name specifies the node name for the search. By default, the 
Device Name field is populated with the wildcard character (*).
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— Max Num to Retrieve restricts the number of instances retrieved. 
The default value is 100.

• A Search button. Clicking Search populates the Search Results panel 
with the node names matching the search criteria.

• The Search Results panel provides the results of your search. The 
Device Name section lists the available nodes to select from.

• Command buttons

— OK copies the selected node into the node field in the main window. 
The Browse Nodes dialog closes.

— Cancel dismisses the dialog. The node field is unchanged.

— Help accesses the online help information for the dialog.

Traffic Management Parameters dialog box
The Traffic Management Parameters dialog opens in the following 
circumstances:

• for both Frame Relay PVC circuits and Frame Relay IP VPN Access 
circuits, when you select Edit -> Edit TM... from the menu bar

• for Frame Relay PVC circuit types, when you click Edit TM... in the 
Circuit Properties panel 

• for Frame Relay IP VPN Access circuit types, when you right click in a 
cell in the TM Profile column in the End Points table

The Traffic Management Parameters dialog lets you create a new traffic 
management template or edit or delete an existing one. 

Traffic Management profiles are stored in the Administration Database. 
Unsaved profiles appear as “Custom” in the database.

See the following sections for related procedures:

• “Creating a new Traffic Management profile” (page 93)

• “Editing a Traffic Management profile” (page 94)

• “Deleting a Traffic Management profile” (page 95)
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See the figure “Traffic Management Parameters dialog for a FR PVC circuit 
type” (page 52).

Figure 1
Traffic Management Parameters dialog for a FR PVC circuit type
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The Traffic Management Parameters dialog for PVC circuits consists of the 
following elements:

• “Master node area” (page 53)

• “Slave node area” (page 53)

• “Command buttons” (page 53)

For Frame Relay IP VPN Access circuits, the dialog only displays the Master 
Node.

Master node area
For information on the various fields in the Master Node area, see 
NN10600-901 Nortel Networks Multiservice Switch 7400/15000/20000 
Frame Relay Configuration Management.

Slave node area
To use the same values for both the Master and Slave endpoint, you enable 
the Use same values as master check box in the Slave Node area. This sets 
all fields in the Slave Node area to read only and uses the values set in the 
Master Node area for both sides of the permanent virtual circuit connection.

To use different values from the Master endpoint, deselect the Use same value 
as master check box and enter the appropriate value in each field.

Command buttons
The Traffic Management dialog has the following action buttons:

• Apply adds the traffic management profile specified in the TM Profile 
field to the list of profiles. Because this action does not save the file, the 
file name will have an asterisk (*) to signify that you must click Apply 
and Save to save it to file. Profiles that are modified but not saved are 
stored in the Administration Database as “Custom”.

• Apply and Save adds the traffic management profile specified in the TM 
Profile field and save it in the eteFrameRelayProfiles.cfg file.

• Delete deletes the traffic management profile specified in the TM 
Profile field.
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• Close closes the dialog. The TM Profile field in the Connection 
Properties area of the Frame Relay service provisioning window displays 
the traffic management profile selected in the dialog.

• Help accesses the online help information for the dialog.

Circuit retrieval dialog boxes
The Frame Relay service provisioning circuit retrieval dialogs let you 
specify the circuit to retrieve from the Administration Database. A 
retrieve dialog opens when you select one of the following commands 
from the File menu:

• Edit Circuit opens the Edit Circuit retrieve dialog

• Delete Circuit opens the Delete Circuit retrieve dialog

Edit Circuit dialog box
Use the Edit Circuit dialog box to retrieve the Frame Relay PVC or IP VPN 
Access circuit that you want to modify. The Edit Circuit dialog box contains 
the following items:

• FR PVC Circuit option button to select a Frame Relay circuit and an 
associated Circuit Id field to identify the specific circuit.

• IP VPN Access Circuit option button to select an IP VPN circuit and 
associated fields to identify the specific circuit. You need specify at least 
one of the following fields:

— Customer 

— Site 

— Access Point

• a selection of command buttons:

— Reset clears the dialog and resets the values back to the wildcard (*) 
character.

— Retrieve retrieves the circuit from the Administration Database. If 
the data is successfully retrieved, the dialog closes and the circuit 
data displays in the Frame Relay service provisioning tool window. 
If two or more circuits have the same ID, the first circuit found is 
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used. If a circuit is not found, a warning message opens and the 
retrieve dialog remains open.

— Cancel closes the dialog box and cancels the retrieval of the circuit 
data.

If you do not know what values to specify in any of the fields, you can use the 
wildcard (*) to retrieve all occurrences. If more than one circuit meets the 
retrieval criteria, a dialog opens from which you can make a selection. You 
can also use the Circuit Viewer tool to search for the desired circuit data. See 
241-6001-011 Preside MDM Fault Management User Guide for the 
procedure to search for a circuit using the Circuit Viewer tool. Selecting a 
circuit in the Circuit Viewer tool sets the context. You can then retrieve the 
current context in the Edit Circuit dialog by selecting the Get Context pop-up 
menu from any of the fields.

The retrieved data displays in the Frame Relay service provisioning window 
as read-only until you successfully validate the circuit.

The command panel displays the Validate... and Apply... buttons. The 
Validate... button is enabled. Clicking Validate... validates the circuit 
configuration against the current node configuration data. If the data matches, 
the applicable fields are set to read-write and the Apply... button is enabled.

If there are differences in the component data, the differences display in the 
status window and you can not edit the circuit. 

If the stored data is incorrect, you can edit the data using the Circuit Database 
Administration tool. 

You can also verify that the network element is running the correct view. If 
not, you may load and activate a different view.

When you click the Apply... button, a Confirm Frame Relay Changes dialog 
box opens and displays all the changes that you have made. The dialog box 
ask if you wish to continue. If you click Yes, the Edit Circuit dialog box 
opens. If you click No, you return to the Frame Relay main window. The 
Apply... button is disabled until the circuit is successfully validated. If any 
discrepancies exist in the circuit, you need to resolve them before the Frame 
Relay tool allows the edit action to continue.
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Delete Circuit dialog box
Use the Delete Circuit dialog box to retrieve the Frame Relay PVC or IP VPN 
Access circuit that you want to delete. The Delete Circuit dialog box contains 
the following items:

• FR PVC Circuit option button to select a Frame Relay circuit and an 
associated Circuit Id field to identify the specific circuit.

• IP VPN Access Circuit option button to select an IP VPN circuit and 
associated fields to identify the specific circuit. You need specify at least 
one of the following fields:

— Customer 

— Site 

— Access Point

• a selection of command buttons:

— Reset clears the dialog and resets the values back to the wildcard (*) 
character.

— Retrieve retrieves the circuit from the Administration Database. If 
the data is successfully retrieved, the dialog closes and the circuit 
data displays in the Frame Relay service provisioning tool window. 
If two or more circuits have the same ID, the first circuit found is 
used. If a circuit is not found, a warning message opens and the 
retrieve dialog remains open.

— Cancel closes the dialog box and cancels the retrieval of the circuit 
data.

If you do not know what values to specify in any of the fields, you can use the 
wildcard (*) to retrieve all occurrences. If more than one circuit meets the 
retrieval criteria, a dialog opens from which you can make a selection. You 
can also use the Circuit Viewer tool to search for the desired circuit data. See 
241-6001-011 Preside MDM Fault Management User Guide for the 
procedure to search for a circuit using the Circuit Viewer tool. Selecting a 
circuit in the Circuit Viewer tool sets the context. You can then retrieve the 
current context in the Edit Circuit dialog by selecting the Get Context pop-up 
menu from any of the fields.
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The retrieved data displays in the Frame Relay service provisioning window 
as read-only.

The command area displays the Delete... button which is enabled. Clicking 
Delete... validates the circuit configuration data that was retrieved from the 
Administration Database against the current node configuration data. If the 
data matches, the circuit is deleted. If there are differences in the component 
data, the differences are displayed in the status window and you can not delete 
the circuit. 

If the stored data is incorrect, you can edit the data using the Frame Relay 
service provisioning tool, or you can repopulate the database. 

You can also verify that the network element is running the correct view. If 
not, you may load and activate a different view. Once the provisioning data is 
successfully activated, the circuit is deleted from the Administration 
Database.

Create Circuit dialog box
You use the Create Circuit dialog box to specify how to apply the connection 
configuration that you have set up in the Frame Relay service provisioning 
tool. 

The Create Circuit dialog box contains the following panels:

• “Open View panel” (page 57)

• “Apply Options panel” (page 58)

• “Command buttons” (page 59)

Open View panel
The Open View panel lets you specify the view to which to apply your 
configuration changes. The Open View panel contains the following options:

• Current
Current copies the current view to the edit view.

• Committed
Committed copies the committed view to the edit view.
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• Edit
Edit uses the edit view.

• Saved
Save loads the specified view. If you select Saved, you need to select one 
of the following options from the drop down list:

— User Specified. When you select User Specified, you need to enter 
a view file name.

— Dated. Type the string “today” or enter a date in the format 
<yymmdd>, where yy is the year, mm is the month and dd is the day. 
When you enter a date, the service data view with the highest version 
number (nn) is found. When an exact match does not exist, the most 
recent service data view, relative to the date is used. That is, the 
dated service data view with the latest date earlier than the given 
date, and with the latest version number, is opened. For additional 
information on dated views, see the section Using dated MCFs in 
241-6001-304 Preside MDM Configuration Management for DPN 
Administration. The file must exist on all the network elements 
being configured.

Apply Options panel
The Apply Options panel lets you specify how to apply the configuration 
changes. The panel contains the following check boxes.

• Save
Save saves the configuration on the node. The Type dropdown list is 
enabled and you can select one of the following format options:

— portable saves the view in portable format

— delta saves the view in delta format

— ascii saves the view in ASCII forma

When you select Save, you need to select one to the following options 
from the drop down list:

— User Specified. You need to enter a view file name in the adjacent 
text box.

— Dated. Type the string “today” or enter a date in the format 
yymmdd. where yy is the year, mm is the month and dd is the day. 
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When you enter a date, the view is saved with the date followed by 
the next version number <nn> in the sequence, in the format 
<yymmdd><nn>. For example, 03012903. The file is created on all 
nodes that are being provisioned. For additional information on 
dated views, see the section “Using dated MCFs” in 241-6001-304 
Preside MDM Configuration Management for DPN Administration.

• Activate
Activate activates the configuration changes. The activation is 
automatically confirmed. If you have configured the system to use an 
Administration Database, the database is populated with the circuit data.

• Commit
Commit commits the configuration as the default at startup. Commit is 
enabled only if you have selected Activate.

Command buttons
The Create dialog box has the following command buttons

• OK
OK begins the provisioning of the configured nodes in the Frame Relay 
connection and closes the Create Circuit dialog box.

• Cancel
Cancel cancels the creation of the circuit and closes the Create Circuit 
dialog box.

Edit Circuit dialog box
Use then Edit Circuit dialog box to indicate how to apply the modifications 
to a configuration. The Edit Circuit dialog opens when you click Apply in the 
Frame Relay service previsioning tool main window when you are modifying 
a configuration.

When you click Apply, the service provisioning tool proceeds to activate the 
changes on the network element, and if successful, stores the provisioning 
data in the Administration Database. 

The Edit Circuit dialog has the following apply options:

• Save saves the configuration on the node. When you select the Save 
option, The Type dropdown list is enabled and you can select one of the 
following format options:
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— portable saves the view in portable format

— delta saves the view in delta format

— ascii saves the view in ASCII format

You need to select one of the following options from the drop down list:

—  User Specified. You need to enter a view file name in the adjacent 
text box.

— Dated. Type the string “today” or enter a date in the format 
yymmdd. where yy is the year, mm is the month and dd is the day. 
When you enter a date, the view is saved with the date followed by 
the next version number <nn> in the sequence, in the format 
<yymmdd><nn>. For example, 03012903. The file is created on all 
nodes that are being provisioned. For additional information on 
dated views, see the section “Using dated MCFs” in 241-6001-304 
Preside MDM Configuration Management for DPN Administration.

• Activate activates the new configuration. The activation is automatically 
confirmed. If you have installed the Administration Database, the 
database is populated with the circuit data.

• Commit commits the configuration as the default at startup. Commit is 
disabled until you select Activate so you cannot commit the view without 
activating the view.

The Edit Circuit dialog has the following command buttons:

• OK begins the provisioning of the configured nodes in the Frame Relay 
connection, and closes the Edit Circuit dialog box.

• Cancel cancels the circuit modification action and closes the dialog box.

For the procedure to edit a circuit, see “Editing a Frame Relay circuit” 
(page 85).

Delete Circuit dialog box
Use the Delete Circuit dialog box to specify how to apply the deletion of a 
circuit. The Delete Circuit dialog opens when you select Delete... in the 
command area of the Frame Relay service provisioning window in a delete 
circuit action.
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The Delete Circuit dialog has the following apply options:

• Save
Save saves the configuration on the node. The Type dropdown list is 
enabled and you can select one of the following format options:

— portable saves the view in portable format

— delta saves the view in delta format

— ascii saves the view in ASCII format

You need to select one of the following options from the drop down list:

—  User Specified. You need to enter a view file name in the adjacent 
text box.

— Dated. Type the string “today” or enter a date in the format 
yymmdd. where yy is the year, mm is the month and dd is the day. 
When you enter a date, the view is saved with the date followed by 
the next version number <nn> in the sequence, in the format 
<yymmdd><nn>. For example, 03012903. The file is created on all 
nodes that are being provisioned. For additional information on 
dated views, see the section “Using dated MCFs” in 241-6001-304 
Preside MDM Configuration Management for DPN Administration.

• Activate activates the new configuration. The activation is automatically 
confirmed. If you have installed the Administration Database, the 
database is populated with the circuit data.

• Commit commits the configuration as the default at startup. Commit is 
disabled until you select Activate so you cannot commit the view without 
activating the view.

The Delete Circuit dialog has the following command buttons:

• OK begins the circuit deletion. The data that is retrieved from the 
Administration Database is validated against the node configuration 
data. If the data matches, the deletion proceeds. If the component data 
differs, the differences are reported in the messages window and the 
circuit deletion does not proceed, and closes the Create Circuit dialog.

• Cancel cancels the circuit deletion action and closes the Delete Circuit 
dialog box.
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For the procedure to delete a circuit, see “Deleting a Frame Relay circuit” 
(page 89).

Dialog boxes for Frame Relay PVCs
The following dialog boxes applies to only Frame Relay PVC circuits:

• “Edit Backup Slave dialog box” (page 62)

• “Customer Search dialog box” (page 63)

Edit Backup Slave dialog box
The Edit Backup Slave dialog lets you create backup slave nodes. Edit 
Backup Slave dialog box opens when you click Edit Backup in the Slave 
Node area of a Frame Relay PVC circuit. 

The Edit Backup Slave dialog consists of the following elements:

• Backup Slaves table which lists all available backup slaves. You select 
one to configure or delete. New backup slaves created in this dialog 
display here. The fields and buttons are described in the Master Node 
area. See “Master panel” (page 36).

• The Backup Slave panel which lets you configure backup slave 
information. The New DLCI field is read only because its value cannot 
be different from the corresponding data link connection identifier 
(DLCI) in the Slave Node area in the main window. The fields and 
buttons are described in the Master Node area; see “Master panel” 
(page 36).

• Command buttons:

— Add adds the backup slave configured in this dialog. The backup 
slave appears in the Backup Slaves table.

— Modify allows you to specify a user ID and password during a 
validate action. During an edit action, the Modify button lets you 
modify the user ID, password, Node Name, and FrUni/Nni instance.

— Delete deletes the backup slave selected in the Backup Slaves table.

— OK saves changes and close the dialog.

— Cancel dismisses the dialog without saving changes.
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— Help accesses the online help information for the dialog.

For relevant procedures, see “Backup slaves configuration” (page 119).

Customer Search dialog box
Use the Customer Search dialog box to search for and select a customer for a 
Frame Relay PVC circuit. You open the Customer Search dialog box by 
clicking the browse button [...] to the right of the Customer field in the Circuit 
Properties panel. The dialog box contains the following items:

• The Filter Customers panel contains the fields which define the search 
criteria. By default these fields are populated with the wildcard character 
(*). You can search on the following items:

— Customer Name

— Business Category

— Country

Further filtering capabilities are provided by the default customer and 
ISP customer check boxes.

This panel contains two command buttons:

— Retrieve starts the search and retrieves the Customers that meet the 
search criteria and displays the results in the List Customers panel.

— Reset lets you reset your search criteria.

• The List Customers panel displays a list of all the Customers that meet 
the search criteria. You can select a Customer from the list.

• Command buttons
The dialog box contains the following command buttons:

— OK closes the dialog box. The Customer field in the Frame Relay 
service provisioning tool window is populated with the Customer 
which you selected in the List Customers panel.

— Cancel cancels the search action.

For the procedure to browse for FR PVC customers see “Browsing 
customers” (page 80).
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Dialog boxes for Frame Relay IP VPN Access 
The following dialog boxes support FR IP VPN access circuit types:

• “Browse Customer dialog box” (page 64)

• “Site Search dialog box” (page 65)

• “Browse VRs/VRFs dialog box” (page 66)

• “Available DLCI dialog box” (page 66)

• “Browse FrDte/Remote Group dialog box” (page 68)

• “Browse lpDlciGroup dialog box” (page 68)

Browse Customer dialog box
Use the Browse Customer dialog boxes to search for and select a customer for 
a Frame Relay 2547 IP VPN Access circuit. You open the Browse Customer 
dialog box by clicking the browse button [...] to the right of the Customer field 
in the Circuit Properties panel. 

The Browse Customers dialog box that opens depends on the circuit type. For 
2764 circuits, the Browse Customers/VRs dialog box opens and displays 
those customers that own VPNs. From this dialog box, you can display the 
VRs of each customer. 

VPN for 2547 circuits the Browse Customers/VRFs dialog box opens and 
displays those customers that own route targets. From this dialog box, you 
can display the VRFs that have customer route targets.

This panel contains two command buttons:

• OK closes the dialog box and populates the service provisioning window 
with the selected customer, and if selected any VR or VRF. 

• Cancel cancels the search action.

For the procedure to browse FR IP VPN Access customers, see “Browsing 
customers” (page 80).
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Site Search dialog box
The Site Search dialog box is used to search for and select a Site for a Frame 
Relay IP VPN Access circuit. The Site entity is a collection of access points 
and is stored in the Site table of the Administration Database. You open the 
Site Search dialog box by clicking the browse button [...] to the right of the 
Site field in the Circuit Properties panel. The dialog box contains the 
following items:

• The Filter Site panel contains the fields which define the search criteria. 
By default these fields are populated with the wildcard character (*). If 
you have entered a Customer in the Frame Relay service provisioning 
window, it is used as a search criteria. You can search on the following 
items:

— Customer Name

— Site Name

— Extranet enabled

This panel contains two command buttons:

— Retrieve starts the search and retrieves the Customers that meet the 
search criteria and displays the results in the List Customers panel.

— Reset lets you reset your search criteria.

• The List Site panel displays a list of all the Sites that meet the search 
criteria. You can select a Site from this list.

• Command buttons
The dialog box contains the following command buttons:

— OK closes the dialog box. The Site field in the Frame Relay service 
provisioning tool window is populated with the name of the Site 
which you selected in the List Sites panel.

If the Site that you have selected is not the same as the one which is 
entered in the Customer field of the Circuit Properties panel, you are 
prompted to synchronize them by changing the Customer to that of 
the Site’s Customer.

— Cancel cancels the search action.
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For the procedure to browse Sites, see “Browsing Sites” (page 106).

Browse VRs/VRFs dialog box
The Browse VRs dialog box is used to list available VRs for a RFC 2764 
Frame Relay IP VPN Access circuits and VRFs for a RFC 2547 IP VPN 
Access circuits. The dialog box opens when you click the browse button [...] 
to the right of either the VR or Vrf field in the Frame Relay service 
provisioning window.

The dialog box contains the following items:

• An Available VR list to provide a list of available VRs or Vrfs on the IP 
VPN Access node

• A status message to indicate to status of the search operation

• Command buttons
The dialog box contains the following command buttons:

— OK closes the dialog box and populates the VR/Vrf field in the 
Frame Relay - Service Provisioning window with the VR/VRF 
which you selected.

— Cancel cancels the browse action.

— Help accesses the on-line help for the dialog box

For the procedure to browse for available VRs or VRFs, see “Browsing VRs 
and VRFs” (page 107).

Available DLCI dialog box
The Available DLCI dialog box is used to list available DLCIs. The dialog 
box opens when you right click in a cell in the Media DLCI, IP Service DLCI, 
or FR Access DLCI columns and select Browse DLCI... from the pop-up 
menu.

For the FR Access DLCI, the values returned depends on the circuit 
configuration selected. Refer to the table “Circuit configurations and values 
returned by the Browse DLCI pop-up menu item” (page 67) for a description 
of the values returned when you browse each column.
241-6001-603   15.1RSUP   



Chapter 3 Frame Relay service provisioning tool user interface   67
 The dialog box contains the following items:

• Fr Interface identifies the Frame Relay instance being searched 

• The Available DLCI list provides a list of available DLCIs for the 
specified instance 

• Command buttons
The dialog box contains the following command buttons:

— OK closes the dialog box and populates the VR/Vrf field in the 
Frame Relay - Service Provisioning window with the VR/VRF 
which you selected.

Table 2
Circuit configurations and values returned by the Browse DLCI pop-up menu item

Circuit configuration Column type Values returned by the Browse DLCI 
pop-up menu command

FrDte BAckhaul and 
Direct circuits

IP Service Access 
DLCI 

 Unused StaticDlci’s of the FrDte.

FR Access DLCI Unused Dlcis from the interface selected 
in the Frame Relay Access Node 
Properties panel.

Optimized Backhaul Media DLCI Unused FrConns of the ipDlciGroup (i.e. 
Media)

 IP Service DLCI Unused Dlcis of the interface selected in 
the IP Service Node Properties.

Frame Relay 
Access DLCI

Unused Dlcis of the interface selected in 
the Frame Relay Access Node 
Properties panel

Optimized Local* Media DLCI Unused FrConn’s of the IpDciGroup (i.e. 
Media). 

Frame Relay 
Access DLCI

Unused Dlcis of the interface selected in 
the Frame Relay Access Node 
Properties panel

* For 2547 circuits, the Browse FrConn popup is not available in the Media DLCI column.
Because the parent component (IpoDlci) is unique for each access point, no FrConn
instances are used. All valid DLCI instances are available for use.
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— Cancel cancels the action.

— Help accesses the on-line help for the dialog box

For the procedure to browse available Dlci’s see “Browsing DLCIs” 
(page 108).

Browse FrDte/Remote Group dialog box
The Browse FrDte/Remote Group dialog box opens when you click the 
browse button [...] to the right of the FrDte field in the IP Service Node 
Properties panel for 2764 FrDte Backhaul and FrDte Direct circuit 
configurations.

The dialog box contains the following elements:

• The FrDte Instance panel displays all FrDte instances on the IP Service 
Node.

• Clicking the Show button populates the RG List panel with the existing 
RemoteGroup instances for the selected FrDte instance.

• Command buttons

— OK populates the FrDte field in the IP Service Node Properties 
panel with the selected FrDte. If you selected the remote group in the 
RG panel, the RemoteGroup field is also populated. The Browse 
dialog closes.

— Cancel dismisses the dialog. The FrDte and RemoteGroup fields 
are unchanged in the main window.

— Help accesses the online help information for the dialog.

For the procedure to browse FrDte and Remote Group instances, see 
“Browsing FrDte and Remote Group instances for 2764 FrDte circuits” 
(page 113).

Browse lpDlciGroup dialog box
The Browse lpDlciGroup dialog box displays a list of the instances of 
lpDlciGroups on the IP service node. This dialog box opens when you click 
the browse button [...] to the right of the lpDlciGroup field in the IP Service 
Node Properties panel for 2764 optimized circuit configurations.
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The Browse dialog box has the following elements:

• Existing lpDlciGroups list which displays all instances of lpDlciGroups 
on the IP service node

• Command buttons

— OK copies the selected node into the Fruni | Frnni Instance field 
in the main window. The Browse dialog closes.

— Cancel dismisses the dialog. The Fruni | Frnni Instance field is 
unchanged.

— Help accesses the online help information for the dialog.

For the procedure to browse for lpDlciGroup instances, see “Browsing 
lpDlciGroup instances for 2764 IP Optimized circuits” (page 112)

Using the keyboard commands
For Frame Relay service provisioning, you can use the keyboard instead of 
the mouse to select a menu option. You can also execute a command by using 
a command accelerator. See the following sections:

• “Mnemonics” (page 69)

• “Command accelerators” (page 70)

Mnemonics
Every menu option in the menu bar has a mnemonic associated with it. Each 
mnemonics usually consists of the Alt key followed by the first letter of the 
menu and the first letter of the menu option. 

Example
To edit the backup slave using mnemonics, press the Alt key plus the 
letter E and then the letter Q.

The single character that selects a given menu option is shown by the 
underscore in the name of the menu’s active name. If there are duplicate 
options in the same menu, the second capital letter is used. If there are 
duplicates and no other capital letters in the menu option, the second letter is 
used.
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Command accelerators
The Frame Relay service provisioning tool provides command accelerators to 
execute menu commands. Each accelerator usually consists of the control key 
followed by the first letter of the menu option. The command accelerator is 
shown beside each menu option.

Example
To edit the backup slave using a command accelerator, press the Control 
key plus the letter B.
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Chapter 4
General procedures

This section provides general procedures for using the Frame Relay service 
provisioning tool.

For procedures that apply to both the FR PVC and FR IP VPN access circuit 
types, see the following sections:

• “Frame Relay service provisioning tool launch points” (page 73)

— Starting the Frame Relay service provisioning tool from the toolset 
window

— Starting the Frame Relay service provisioning tool from Nodal 
Provisioning

— Starting the Frame Relay service provisioning tool from the 
Network Viewer Start Tool menu

— Starting the Frame Relay service provisioning tool from the Circuit 
Viewer Tools menu

— Starting the Frame Relay service provisioning tool from the 
Database Administration tool

• “Connecting to a network element” (page 79)

• “Browsing customers” (page 80)

• “Browsing nodes” (page 83)

• “Browsing service interfaces” (page 84)

• “Editing a Frame Relay circuit” (page 85)
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• “Deleting a Frame Relay circuit” (page 89)

• “Traffic Management procedures” (page 92)

— “Creating a new Traffic Management profile” (page 93)

— “Editing a Traffic Management profile” (page 94)

— “Deleting a Traffic Management profile” (page 95)

• “Applying provisioning changes” (page 96)

— “Applying the service creation” (page 97)

— “Applying the service deletion or modification” (page 99)

• “Managing Invalid circuit conditions” (page 101)

— “Correcting the circuit in the network” (page 103)

— “Manually deleting a circuit from the network and Administration 
Database” (page 102)

• “General procedures for Frame Relay IP VPN Access circuits” 
(page 105)

— “Browsing Sites” (page 106)

— “Browsing VRs and VRFs” (page 107)

— “Browsing DLCIs” (page 108)

— “Browsing lpDlciGroup instances for 2764 IP Optimized circuits” 
(page 112)

— “Browsing FrDte and Remote Group instances for 2764 FrDte 
circuits” (page 113)

— “Clearing a row in the End Points table” (page 110)

— “Selecting a Traffic Management profile” (page 111)

— “Launching Embedded Nodal Provisioning” (page 114)
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Frame Relay service provisioning tool launch points
You can start the Frame Relay service provisioning tool from various 
locations in Preside Multiservice Data Manager (MDM). For additional 
information, see the following sections: 

• “Starting the Frame Relay service provisioning tool from the toolset 
window” (page 74)

•  “Starting the Frame Relay service provisioning tool from Nodal 
Provisioning” (page 75)

• “Starting the Frame Relay service provisioning tool from the Network 
Viewer Start Tool menu” (page 76)

• “Starting the Frame Relay service provisioning tool from the Circuit 
Viewer Tools menu” (page 77)
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Starting the Frame Relay service provisioning tool from the 
toolset window

You can launch the Frame Relay service provisioning tool from the 
Configuration entry in the toolset window.

Prerequisites
• you have started Preside Multiservice Data Manager (MDM) and the 

toolset window is displayed

Procedure steps
1 In the application main window, select Configuration-> Passport-> 

Service Provisioning -> Frame Relay.

2 If the Administration Database is installed, the database authentication 
dialog box opens.

3 In the User name and Password fields, enter your database user name 
and password and click OK.

The Service Provisioning - Frame Relay window opens.
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Starting the Frame Relay service provisioning tool from 
Nodal Provisioning 

You can access the Frame Relay service provisioning tool from the Nodal 
Provisioning tool menu bar.

Prerequisites
• you have opened the Nodal Provisioning tool. See 241-6001-610 Preside 

MDM Nodal Provisioning User Guide for start-up procedures.

Procedure steps
1 In the menu bar of the Nodal Provisioning tool main window, select 

External Tools -> Service Provisioning -> Frame Relay.

If the Administration Database is installed, the database authentication 
dialog box opens.

2 In the User name and Password fields, enter your database user name 
and password.

3 Click OK.

The Service Provisioning - Frame Relay window opens.
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Starting the Frame Relay service provisioning tool from the 
Network Viewer Start Tool menu

You can launch the Frame Relay service provisioning tool from Network 
Viewer. When you do, the Network Viewer remains open and you can 
continue to use it.

Prerequisites
• you have started Preside Multiservice Data Manager (MDM) and the 

toolset window is displayed

Procedure steps
1 In the application main window, select Fault -> Network Viewer.

The Network Viewer window opens.

2 In the Network Viewer window, select the nodes required to provision the 
Frame Relay service by doing one of the following:

• click on the background of the Network Viewer window, drag the 
mouse and release it when the desired nodes are included in the 
area where you dragged the mouse

• press the Shift key and click on the nodes that you want to use to 
create the Frame Relay service

3 Click the mouse while holding the Shift key and select Start Tool -> 
Configuration -> Service Provisioning -> Frame Relay.

4 If the Administration Database is installed, the Administration Database 
authentication dialog box opens.

5 In the User name and Password fields, enter your database user name 
and password and click OK.

The Service Provisioning - Frame Relay main window opens. 

If you have selected only one node when you launch the Frame Relay 
service provisioning tool, that node is the master node.

If you select two nodes, the first selected node is the master. The second 
selected node is the slave. All the other nodes are unused.
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Starting the Frame Relay service provisioning tool from the 
Circuit Viewer Tools menu 

You can launch the Frame Relay service provisioning tool from the menu bar 
in Circuit Viewer or from a selected circuit in Circuit Viewer.

Prerequisites
• you have started Preside Multiservice Data Manager (MDM) and the 

toolset window is displayed

Procedure steps
1 Open Circuit Viewer from the application main window:

Fault -> Circuit Viewer

2 From the Circuit Viewer menu bar, select Tools -> Frame Relay Service 
Provisioning, or 

Select a circuit, right click on the selected circuit and from the pop-up 
menu, select Launch Frame Relay SP.

3 If the Administration Database is installed, the database authentication 
dialog box opens.

4 In the User name and Password fields, enter your database user name 
and password and click OK.

The Service Provisioning - Frame Relay main window opens. 
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Starting the Frame Relay service provisioning tool from the 
Database Administration tool

You can launch the Frame Relay service provisioning tool from the Database 
Administration tool.

Prerequisites
• you have started Preside Multiservice Data Manager (MDM) and the 

toolset window is displayed

• the MDM Administration Database tool must be installed

Procedure steps
1 Open the Administration Database tool from the application window:

System -> Administration -> MDM Database Administration

2 From the Database Administration menu bar, select Tools -> Frame 
Relay Service Provisioning.

3 In the User name and Password fields, enter your database user name 
and password and click OK.

The Service Provisioning - Frame Relay main window opens. 
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Connecting to a network element
To specify a user ID and password to login to the network element, use the 
Set Default Authentication dialog box. 

Prerequisites
• You have launched the Frame Relay service provisioning tool.

• You have opened the Set Default Authentication dialog box. This dialog 
box opens when you select Options -> Set Default Authentication... from 
the Service Provisioning-Frame Relay menu bar, or as a prompt the first 
time you perform an action that requires a connection to the network 
element.

Procedure steps
1 In the Set Default Authentication dialog box, type a user ID and 

password.

2 Click OK.
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Browsing customers 
You can browse the customer table in the Administration Database to search 
for and select a customer of a Frame Relay PVC or 2547 IP VPN Access 
circuit. Use one of the following procedures:

• “Procedure steps for FR PVC” (page 80)

• “Procedure steps for FR IP VPN Access” (page 82)

Prerequisites
• the Preside Multiservice Data Manager (MDM) Administration 

Database is installed

• selected circuit type is FR PVC or FR IP VPN Access

• you have clicked the browse button [...] to the right of the Customer field 
in the Frame Relay service provisioning tool to open the browse dialog 
box

Procedure steps for FR PVC
1 By default, the fields in the Filter Customers panel, are populated with 

the wild card character [*]. You can limit the scope of the search criteria 
by entering a value in one or more of the following fields:

• Customer Name

• Business Category
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• Country

2 If required, retrieve the single default customer by selecting the default 
customer check box.

3 If required, retrieve the single ISP customer by selecting the ISP 
customer check box.

4 Click Retrieve.

The customers that meet the criteria that you specified display in the List 
Customers panel.

5 From the list, select the customer and click OK.

The selected customer appears in the Customer field in the Frame 
Relay- Service Provisioning window.
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Procedure steps for FR IP VPN Access
1 In the Browse Customer dialog box, select the customer.

2 If required, select an available VR or VRF.

3 Click OK. 

The selected information displays in the Frame Relay - Service 
Provisioning window.
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Browsing nodes
You can search for available nodes and select the desired node from a list, 
using the Browse Nodes dialog box.

Prerequisites
• you have clicked the browse nodes [...] button to the right of the Node 

Name field. 

Procedure steps
1 In the Browse Nodes dialog box, enter the search criteria, or use the wild 

card character (*) to search for all nodes.

2 Optionally, change the number of instances to retrieve. The default is 100.

3 Click Search.

The available nodes that match the search criteria are listed in the Search 
Results panel.

4 Select a node from the list.

5 Click OK to populate the Node Name field in the Service Provisioning - 
Frame Relay window.
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Browsing service interfaces 
You can search for and select a Frame Relay user-to-network 
interface|network-to-network interface and/or a data link connection 
identifier (DLCI) from a list of available interfaces and identifiers on a 
selected node.

Prerequisites
• you have specified a node in the Node Name field

• you have logged into the node. See “Connecting to a network element” 
(page 79)

Procedure steps
1 Click the browse [...] button to the right of the Fruni|Frnni Instance field.

The Browse Service Interfaces dialog box opens and displays a list that 
contains the following information:

• all Frame Relay user-to-network interface (Fruni) or Frame Relay 
network-to-network interface (Frnni) instances

• the Data Network Address (DNA) value for the corresponding 
Fruni|Frnni instance

• the port interface for the corresponding Fruni|Frnni instance (for 
backhaul configurations only)

2 Select a Fruni|Frnni instance.

3 For FR PVC circuit searches, click Show to populate the Unassigned 
DLCI area with the existing Data Link Connection Identifiers for the 
selected Frame Relay Fruni|Frnni.

4 Click OK to populate the Fruni|Frnni Instance field in the Frame Relay - 
Service Provisioning window.
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Editing a Frame Relay circuit 
Use this procedure to modify a Frame Relay PVC or IP VPN Access circuit 
that is stored in the Administration Database. 

You can use the Circuit Viewer tool to select the circuit that you want to 
retrieve. Selecting a circuit in Circuit Viewer puts the circuit in context. The 
Frame Relay tool gets the circuit from context and populates the relevant 
fields with circuit data. For IP VPN Access circuits, an access point can have 
four CoS indexes with each index having one circuit. When you select a CoS 
circuit in the Circuit Viewer tool, the Frame Relay tool searches for the parent 
access point and retrieves all circuits belonging to that access point. 

Procedure steps
1 You can use the Circuit Viewer tool or the Frame Relay service 

provisioning tool to specify the circuit that you want to edit. Use one of the 
following methods: 

• From Circuit Viewer, retrieve a circuit from the Administration 
Database and then start the Frame Relay service provisioning tool in 
context. For details, see 241-6001-011 Preside MDM Fault 
Management User Guide.

• If you want to use the Frame Relay service provisioning tool, start the 
procedure at step 2.

2 From the Frame Relay service provisioning File menu, select Edit 
Circuit....

The Edit Circuit retrieval dialog box opens.

3 If you used the Circuit Viewer method to specify a circuit, the Edit Circuit 
retrieval dialog box identifies the circuit that you want to edit. Go to step 5.

Note:  You can change your selection by selecting another circuit in 
Circuit Viewer and then right-clicking in any of the fields in the Edit Circuit 
dialog box to open a pop-up menu. From the pop-up menu, select Get 
Context. 

4 Specify the Frame Relay circuit that you want to retrieve.
For Frame Relay PVC circuits

• Click FR PVC Circuit.

• In the Circuit Id box, type the circuit identifier. If you do not know the 
circuit identifier, you can type an asterisk (*) to retrieve a list of circuits 
from which you can make a selection.
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For Frame Relay IP VPN Access circuits

• Click FR IP Access Circuit.

• In the Customer, Site, and Access Point boxes, type the 
appropriate values. If you do not know the customer, site, or access 
values, you can type an asterisk (*) in any of these boxes to display 
a list of circuits from which you can make a selection.

5 Click Retrieve.

If the retrieval is successful, the circuit data displays in the Frame Relay 
service provisioning window. All fields are in read-only mode. The 
Validate button is enabled and the Apply button is disabled. The Edit 
Circuit circuit retrieval dialog box closes. 

If more than one circuit meets the criteria, a dialog box opens and lists all 
the circuits that meet the criteria. Select a circuit from the list, and click 
OK.

If the circuit is not found, a message dialog box opens and the Edit 
Circuit retrieve dialog box remains open. 

6 If you have not yet authenticated the node, select 
Options -> Set Default Authentication to open the Set Default 
Authentication dialog box.

7 In the Set Default Authentication dialog, type a user ID and password 
to connect to the nodes in the PVC or IP VPN path and click OK.

8 To validate the data retrieved from the Administration Database against 
the current node configuration data, click Validate.

The Apply button, and all fields except the User Id and Password fields 
are disabled during the validate. If the data matches, the applicable fields 
and the Apply button become enabled (read-write) after which you can 
proceed to edit the circuit configuration. Proceed to step 9.

If the validation fails because the circuit in the Administration Database is 
invalid, this information is logged in the Service Provisioning Frame 
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Relay Real Time Log Display window. This indicates that one or more of 
the provisioned components no longer exist in the network.

The delete action does not proceed.

Refer to “Managing Invalid circuit conditions” (page 101) for the 
procedure to correct an invalid circuit condition.

9 After a successful validation, you can make the necessary changes to the 
configuration data from the Frame Relay service provisioning window.

10 When you complete your modifications, click Apply.

The Frame Relay service provisioning tool checks if any mandatory 
configuration data is missing or if discrepancies exist. If so, a dialog opens 
identifying the missing information or discrepancy. Enter the missing 
information or correct any discrepancies and click Apply again.

If all required data has been entered, a confirmation dialog box opens 
summarizing the changes made to the circuit.

11 Click OK to confirm the circuit changes before they are applied.
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12 The Edit Circuit dialog box opens.

13 Proceed to apply the configuration, see “Applying the service deletion or 
modification” (page 99).
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Deleting a Frame Relay circuit 
Use this procedure to delete an existing Frame Relay PVC or IP VPN Access 
circuit that is stored it in the Administration Database. 

You can use the Circuit Viewer tool to select the circuit that you want to 
delete. Selecting a circuit in Circuit Viewer puts the circuit in context. The 
Frame Relay tool gets the circuit from context. For IP VPN Access circuits, 
an access point can have four CoS indexes with each index having one circuit. 
When you select a CoS circuit in the Circuit Viewer tool, the Frame Relay 
tool searches for the parent access point and retrieves all circuits belonging to 
that access point. 

Procedure
1 You can use the Circuit Viewer tool or the Frame Relay service 

provisioning tool to specify the circuit that you want to delete. Use one of 
the following methods: 

• From Circuit Viewer, retrieve a circuit from the Administration 
Database and then start the Frame Relay service provisioning tool in 
context. For details, see 241-6001-011 Preside MDM Fault 
Management User Guide.

• If you want to use the Frame Relay service provisioning tool, start the 
procedure at step 2.

2 From the Frame Relay service provisioning File menu, select Delete 
Circuit....

The Delete Circuit retrieval dialog box opens.

3 If you used the Circuit Viewer method to specify a circuit, the Delete 
Circuit retrieval dialog box identifies the circuit that you want to delete. Go 
to step 5.

Note:  You can change your selection by selecting another circuit in 
Circuit Viewer and then right-clicking in any of the fields in the Delete 
Circuit dialog box to open a pop-up menu. From the pop-up menu, select 
Get Context. 

4 Specify the Frame Relay circuit that you want to retrieve.
For Frame Relay PVC circuits

• Click FR PVC Circuit.
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• In the Circuit Id box, type the circuit identifier. If you do not know the 
circuit identifier, you can type an asterisk (*) to retrieve a list of circuits 
from which you can make a selection.

For Frame Relay IP VPN Access circuits

• Click FR IP Access Circuit.

• In the Customer, Site, and Access Point boxes, type the 
appropriate values. If you do not know the customer, site, or access 
values, you can type an asterisk (*) in any of these boxes to display 
a list of circuits from which you can make a selection.

5 Click Retrieve.

If the retrieval is successful, the circuit data displays in the Frame Relay 
service provisioning window. All fields are in read-only mode. The Delete 
button is enabled. The Delete Circuit circuit retrieval dialog box closes. 

If more than one circuit meets the criteria, a dialog box opens and lists all 
the circuits that meet the criteria. Select a circuit from the list, and click 
OK.

If the circuit is not found, a message dialog box opens and the Delete 
Circuit retrieve dialog box remains open. 

6 If you have not yet authenticated the node, select Options -> Set Default 
Login to open the Set Default Authentication dialog box.

7 Type a user ID and password to connect to the node in the PVC path and 
click OK.

8 Click Delete.

The Delete Circuit dialog box opens. 

Before performing the deletion, the data that was retrieved from the 
Administration Database is validated against the current view on the 
node. If successful, proceed to step 6.

If the validation fails because the circuit in the Administration Database is 
invalid, this information is logged in the Service Provisioning Frame 
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Relay Real Time Log Display window. This indicates that one or more of 
the provisioned components no longer exist in the network.

The delete action does not proceed.

Refer to “Managing Invalid circuit conditions” (page 101) for the 
procedure to correct an invalid circuit condition.

9 In the Delete Circuit dialog box, specify how to apply the deletion of the 
circuit. For the procedure to apply a deletion, see “Applying the service 
deletion or modification” (page 99).
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Traffic Management procedures
See the following sections for traffic management (TM) procedures:

• “Creating a new Traffic Management profile” (page 93)

• “Editing a Traffic Management profile” (page 94)

• “Deleting a Traffic Management profile” (page 95)
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Creating a new Traffic Management profile
You can create and save a new Traffic Management profile. The default 
profile, named default, is available as a starting point. It cannot be deleted but 
it can be modified.

Prerequisites
• the Frame Relay service provisioning tool main window is open

Procedure steps
1 Click Edit TM... in the main window of the Frame Relay service 

provisioning tool for Frame Relay PVC circuits, or select Edit TM... from 
the pop-up menu in the TM Profile column of the End Points table for 
Frame Relay IP VPN Access circuits

The Traffic Management Parameters dialog box opens.

2 Type a new Traffic Management Profile name in the TM Profile field.

3 Complete all the fields in the Master Node area. 

Note:  The default values shown were defined on the node

4 Click the Use same values check box to use the same values in the 
Slave Node area as the Master Node area. All fields in the Slave Node 
area become read only and the system uses the values set in the Master 
Node area for both sides of the PVC connection. 
To use different values, edit the fields as needed.

5 Click Apply and Save to save the profile.

6 Click Close to close the dialog.

The TMProfile field on the main window is populated with the new profile 
name.
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Editing a Traffic Management profile
You can edit the Traffic Management profile and apply the changes with or 
without saving the profile.

Prerequisites
• the Frame Relay service provisioning tool main window is open

Procedure steps
1 Click Edit TM... in the main window of the Frame Relay service 

provisioning tool for Frame Relay PVC circuits, or select Edit TM... from 
the pop-up menu in the TM Profile column of the End Points table for 
Frame Relay IP VPN Access circuits

The Traffic Management Parameters dialog box opens.

2 Select a traffic management profile in the TM Profile field.

3 Edit the fields as needed. Deselect the Use same values as master 
check box to edit the values in the Slave Node area. 

4 If you want to apply the changes without saving the profile, click Apply.

Because this action does not save the file, the file name will have an 
asterisk (*) to signify that you must click Apply and Save to save it to 
file.The TM profile is stored in the Administration Database as “custom”. 
These changes will be lost when you exit the application.

If you want to apply the changes and save the profile, click Apply and 
Save.

5 Click Close to close the dialog.

The TM Profile field in the main window is populated with the profile name 
from the dialog. The modified and saved TM profile is stored in the 
Administration Database.

If you use the same file name when you save the TM profile, the profile is 
stored in the Administration Database with the same name as before but 
the parameters have the new values.

If you changed the name of the TM profile by typing a new name in the 
TM Profile List field, the TM profile is stored in the Administration 
Database with the new name.
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Deleting a Traffic Management profile
You can delete any Traffic Management (TM) profile, except the default 
profile named default.

Prerequisites
• the Frame Relay service provisioning tool main window is open

Procedure steps
1 Click Edit TM... in the main window of the Frame Relay service 

provisioning tool for Frame Relay PVC circuits, or select Edit TM... from 
the pop-up menu in the TM Profile column of the End Points table for 
Frame Relay IP VPN Access circuits

The Traffic Management Parameters dialog box opens.

2 Select the TM profile in the TM Profile field.

3 Click Delete to delete the profile.
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Applying provisioning changes
See the following sections to apply provisioning changes:

• “Applying the service creation” (page 97)

• “Applying the service deletion or modification” (page 99)
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Applying the service creation
After you create a circuit, you need to apply the configuration changes. The 
Frame Relay service provisioning tool begins the apply process by 
provisioning any nodes that have been affected. Following the provisioning, 
the new provisioning data is stored in the Administration Database. The 
modified circuit can be monitored from the Circuit Viewer tool.

Prerequisites
• you have entered all mandatary data required to create a circuit 

• you have set the default login. See “Connecting to a network element” 
(page 79)

• you have clicked Apply... in the Frame Relay service provisioning tool 
main window to open the Create Circuit dialog box.

Procedure steps
1 In the Open View panel of the Create Circuit dialog box, select the view 

to which you want to apply the configuration changes:

• Click Current to copy the current view into the edit view.

• Click Committed to copy the saved version of the current view into 
the edit view.

• Click Edit to use the existing edit view.

• Click Saved and then select either User Specified or Dated from the 
drop down list.

If you select User Specified, enter a file name in the adjacent text 
box.

If you select Dated, type the string “today” or enter a date in the 
format yymmdd where yy is the year, mm is the month and dd is the 
day. When you enter a date, the service data view with the highest 
version number <nn> is found. When an exact match does not exist, 
the most recent service data view, relative to the date is used. That 
is. the dated service data view with the latest date earlier that the 
given date, and with the latest version number, is opened. For 
additional information on dated views, see the section Using dated 
MCFs in 241-6001-304 Preside MDM Configuration Management for 
DPN Administration.
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2 To save the configuration, in the Apply Options panel, select Save. 

3 From the Type dropdown list, select one of the following format options:

• portable saves the view in portable format

• delta saves the view in delta format

• ascii saves the view in ASCII format

4 From the drop down list, select one of the following options:

• User Specified. Enter a view file name in the adjacent text box.

• Dated. Type the string “today” or enter a date in the format yymmdd. 
where yy is the year, mm is the month and dd is the day. When you 
enter a date, the view is saved with the date followed by the next 
version number <nn> in the sequence, in the format 
<yymmdd><nn>. For example, 03012903. The file is created on all 
nodes that are being provisioned. For additional information on dated 
views, see the section “Using dated MCFs” in 241-6001-304 Preside 
MDM Configuration Management for DPN Administration.

5 To activate the new configuration, select Activate.
The activation is automatically confirmed. If you have configured the 
system to use an Administration Database, the database is populated 
with the circuit data.

6 To commit the configuration as the default on startup, select Commit. You 
must have selected Activate before you can select the Commit option.

7 Click OK to initiate the provisioning of the configured nodes in the Frame 
Relay connection, and close the Create Circuit dialog.

Provisioning information and error messages, if any, appear in the Real 
Time Log Display window while the connection is being set up.
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Applying the service deletion or modification
After you modify or delete a circuit, you need to apply the configuration 
changes. The Frame Relay service provisioning tool begins the apply process 
by re-provisioning any nodes that have been affected by the changes. 
Following the re-provisioning, the new provisioning data is stored in the 
Administration Database. The modified circuit can be monitored from the 
Circuit Viewer tool.

Prerequisites
• you have modified the configuration of the circuit or modified node 

attributes. See “Editing a Frame Relay circuit” (page 85) or “Deleting a 
Frame Relay circuit” (page 89)

• you have set the default login. See “Connecting to a network element” 
(page 79)

• you have clicked Apply... to open the Edit Circuit dialog box, or Delete... 
to open the Delete Circuit dialog box

Procedure steps
1 For an edit circuit action, an Edit Circuit dialog box opens after you click 

Apply.

 For a circuit deletion, the Delete Circuit dialog box opens.

If mandatory data is missing, a message dialog opens specifying the 
missing data. Return to step 1 and enter the missing data.

2 In the Edit Circuit or Delete Circuit dialog box, click Save.

3 From the Type drop down list, select one of the following format options:

• portable saves the view in portable format.

• delta saves the view in delta format

• ascii saves the view in ASCII format

4 From the drop down list, select one of the following options:

• User Specified. Enter a view file name in the adjacent text box.

• Dated. Type the string “today” or enter a date in the adjacent text 
field. Use the format yymmdd. where yy is the year, mm is the month 
and dd is the day. When you enter a date, the view is saved with the 
date followed by the next version number <nn> in the sequence, in 
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the format <yymmdd><nn>. For example, 03012903. The file is 
created on all nodes that are being provisioned. For additional 
information on dated views, see the section “Using dated MCFs” in 
241-6001-304 Preside MDM Configuration Management for DPN 
Administration.

5 Select Activate to activate the new configuration.

The activation is automatically confirmed. If you have configured the 
system to use an Administration Database, the database is populated 
with the circuit data.

The new configuration view is activated on the node and after it is 
successfully activated, it is saved to the Administration Database.

6 To commit the configuration as the default at startup, select Commit. You 
need to select the Activate option before you can select the Commit 
option. 

7 Click OK.
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Managing Invalid circuit conditions
Use the following procedures to resolve an invalid circuit condition. An 
invalid circuit condition may occur in the following circumstances:

• the Administration Database is not synchronized with the network

• erroneous provisioning changes have occurred in the network

To resolve an invalid circuit condition, you can take the following actions:

• remove the circuit from both the database and the network by using one 
of the following procedures:

— reload the affected nodes into the Administration Database. For the 
relevant procedure, refer to 241-6001-400 Preside MDM 
Administration Database User Guide.

— manually remove the circuit from both the Administration Database 
and the network. See “Manually deleting a circuit from the network 
and Administration Database” (page 102).

• resolve the circuit in the network so that it aligns with the Administration 
Database. This is achieved by provisioning the missing pieces in the 
network. See “Correcting the circuit in the network” (page 103).
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Manually deleting a circuit from the network and 
Administration Database

You can manually remove an invalid circuit from both the Administration 
Database and the network. 

Procedure steps
1 Before deleting the circuit from the Administration Database, determine if 

there are any components of the circuit still provisioned in the network.

To identify data still provisioned in the network, you need to locate the 
invalid circuit using the Circuit Viewer tool. Refer to the Circuit Viewer 
section in 241-6001-011 Preside MDM Fault Management User Guide for 
procedures to use the Circuit Viewer tool.

a. Open Circuit Viewer and locate the invalid circuit using the Circuit 
Retrieval Criteria panel.

b. From the Circuit(s) found list, select the circuit.

c. Right-click on the circuit and from the pop-up menu, select Start 
State Polling.

d. In the Circuit details panel, select the Circuit components tab.

The state of all components is displayed in the State column. 
Components that are marked “purple” no longer exist in the network. 
All other components, independent of the state reported, exist in the 
network.

2 Manually delete all DLCI components using one of the following methods:

Note:  You need to log into each node on which components for the circuit 
exist, check for the presence of the components, and delete each 
component found. Once all necessary components on a given node are 
deleted, you need to activate the view 

• the delete component capability of the Nodal Provisioning tool. Refer 
to 241-6001-610 Preside MDM Nodal Provisioning User Guide for 
the relevant procedure.

• the node command line interface via telnet

3 Once the circuit is completely removed from the network, use the 
Database Administration tool to delete the circuit from the Administration 
Database. For the relevant procedure, refer to 241-6001-400 Preside 
MDM Administration Database User Guide.
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Correcting the circuit in the network
You can resolve an invalid circuit condition by aligning the circuit in the 
network with the Administration Database. This is achieved by provisioning 
the missing pieces in the network.

Procedure steps
1 Before correcting the circuit in the network to align with the Administration 

Database, determine which components are missing and if there are any 
components of the circuit still provisioned in the network.

To identify data still provisioned in the network, you need to do the 
following tasks:

• Open the Frame Relay service provisioning tool to view the 
components of the circuit (for instance, its interfaces and circuit 
pieces). These components can span several nodes.

• log into each participating node and check for the presence of the 
components. This can be done using either the Nodal Provisioning 
tool (see 241-6001-610 Preside MDM Nodal Provisioning User 
Guide) or the node command line interface via telenet.

2 Once you have determine which components are missing, use one of the 
following methods to correct the circuit in the network:

• reload views onto the nodes that are improperly configured. You can 
only use this approach if the provisioning error was a result of an 
incorrect view being loaded onto a node. Preside Multiservice Data 
Manager (MDM) does not provide a system that provides history of 
views loaded onto the nodes, however there are several tools that 
can assist in this process, including the Configuration Repository and 
the Network Reporting System. For information on these tools, see 
241-6001-400 Preside MDM Administration Database User Guide 
and 241-6001-022 Preside MDM Network Reporting System User 
Guide. After you have made the network corrections, you can use the 
service provisioning tool to validate the circuit. It will mark the circuit 
as “Normal” in the Administration Database so it becomes 
manageable.

• delete the circuit from both the Administration Database and the 
network and reprovision the entire circuit. You need to use this 
approach when the provisioning cannot be corrected by reloading the 
views onto the nodes. First record the nodes, interfaces, connection 
components (VPC/VCC, DLCI), customer, and traffic management 
profiles using the procedures described in step 1. Then follow the 
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procedure “Manually deleting a circuit from the network and 
Administration Database” (page 102) to delete the circuit. Once the 
circuit is deleted, you can use the service provisioning tool to 
provision the circuit, using the information that you recorded.
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General procedures for Frame Relay IP VPN Access circuits
The following procedures apply to all circuit configurations for Frame Relay 
IP VPN access. 

• “Browsing Sites” (page 106)

• “Browsing VRs and VRFs” (page 107)

• “Browsing DLCIs” (page 108)

• “Browsing lpDlciGroup instances for 2764 IP Optimized circuits” 
(page 112)

• “Browsing FrDte and Remote Group instances for 2764 FrDte circuits” 
(page 113)

• “Clearing a row in the End Points table” (page 110)

• “Selecting a Traffic Management profile” (page 111)

• “Launching Embedded Nodal Provisioning” (page 114)

See also “Frame Relay circuits with IP access for 2547 VPNs” (page 123) for 
procedures specific to provisioning RFC 2547 Frame Relay with IP access, 
and “Frame Relay circuits with IP access for 2764 VPNs” (page 131) for 
procedures specific to provisioning RFC 2764 Frame Relay with IP access.
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Browsing Sites 
You can browse the site table in the Administration Database to search for and 
select a Site for a Frame Relay IP VPN Access circuit. 

Prerequisites
• the Preside Multiservice Data Manager (MDM) Administration 

Database is installed

• you have clicked the browse button [...] to the right of the Site field in the 
Frame Relay service provisioning tool to open the Site Search dialog box

Procedure steps
1 In the Filter Site panel, enter the search criteria by completing one or 

more of the following fields:

• Customer Name, if required. If you entered a customer on the 
service provisioning window, the Site Search dialog opens with the 
selected customer in the Customer Name field.

• Site Name. The site name must be unique for the customer. To add 
a description for the site, use the Administration Database tool.

By default these fields are populated with the wild card character [*]. 

2 Click Retrieve.

3  The sites that meet the criteria that you specified are listed in the List 
Sites panel.

4 Select the Site and click OK.

The selected Site appears in the Site field in the Service Provisioning - 
Frame Relay window.
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Browsing VRs and VRFs
On the 2764 VPN circuit configurations, you can browse for Virtual Routers 
(VRs) available on the IP Service Node. Similarly, for 2547 VPNs you can 
search for available Virtual Routing Functions (VRFs) available on the IP 
Service Node.

Prerequisites
• you have clicked the browse button [...] to the right of the VR/Vrf field 

in the IP Service Node Properties panel

• the VR or VRF must be present on the node. If the VR or VRF is not 
present an error will occur at apply time.

Procedure steps
1 The Browse VRs dialog box opens with a list of available VRs or Vrfs.

2 Select a VR or Vrf from the list and click OK.

The VR/Vrf field in the Frame Relay - Service Provisioning window is 
populated with the selected VR/Vrf.
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Browsing DLCIs
You can browse for available DLCIs from the Frame Relay Access DLCI, the 
IP Service DLCI, or Media DLCI columns in the End Points table of Frame 
Relay IP VPN Access circuits. 

When browsing for unassigned DLCIs, the DLCI’s already entered are 
considered used and, therefore, do not appear in the unassigned list.

The following values are returned when browsing DLCIs from various 
columns:

• For FrDte circuit configurations:

— browsing the IP Service DLCI column, unused StaticDlci’s of the 
FrDte

— browsing the FR Access DLCI column, unused Dlci’s from the 
interface selected in the Frame Relay Access Node Properties panel

• Optimized Backhaul

— browsing the Media DLCI column, unused FrConn’s of the 
ipDlciGroup (i.e. the Media)

— browsing the IP Service DLCI column, unused Dlci’s of the 
interface selected in the IP Service Node Properties panel

— browsing the FR Access DLCI column, unused Dlci’s from the 
interface selected in the Frame Relay Access Node Properties panel

• Optimized Local

— browsing the Media DLCI column, unused FrConn’s of the 
ipDlciGroup (i.e. the Media)

— browsing the FR Access DLCI column, unused Dlci’s from the 
interface selected in the Frame Relay Access Node Properties panel

Procedure steps
1 Right-click an entry in a DLCI column and select the Browse DLCI... pop-

up menu item.

The Browse DLCI dialog box opens with a list of available DLCIs.

2 Select a DLCI from the list, and click OK.
241-6001-603   15.1RSUP   



Chapter 4 General procedures   109
The column field in the End Points table, is populated with the selected 
DLCI.
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Clearing a row in the End Points table
Clearing a row in the End Points table of Frame Relay IP VPN Access circuits 
removes the content from the row.

Procedure steps
1 Right-click in a cell in the CoS Index column of the End Points table.

2 Select Clear Row from the pop-up menu.

All the fields in the row are cleared.
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Selecting a Traffic Management profile
You can select a Traffic Management (TM) Profile from the TM Profile 
column in the End Points table of Frame Relay IP VPN Access circuits.

Procedure steps
1 Left-click in a cell in the TM Profile column of the End Points table.

A drop down list of available TM profiles opens.

2 Select a TM profile from the list.
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Browsing lpDlciGroup instances for 2764 IP Optimized 
circuits

You can browse for available media on the IP Service Node for the 2764 IP 
Optimized Local and IP Optimized Backhaul circuit configurations. The 
media for the 2764 IP Optimized circuits is the lpDlciGroup component.

Prerequisites
• you have clicked the browse button [...] to the right of the lpDlciGroup 

field in the IP Service Node panel to open the browse dialog box

Procedure steps
1 The browse dialog box, shows a list of the instances of the lpDlciGroup 

that are on the IP Service Node.

2 Select an instance, and click OK.

The lpDlciGroup field in the IP Service Node panel is populated with the 
selected lpDlciGroup instance.
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Browsing FrDte and Remote Group instances for 2764 
FrDte circuits

You can browse for the FrDte instance and/or available media on the IP 
Service Node for the 2764 FrDte Direct and FrDte Backhaul circuit 
configurations using the Browse FrDte/Remote Group dialog box. The media 
for 2764 FrDte circuits is the remoteGroup component and it is created under 
the FrDte when you apply the provisioning.

Prerequisites
• you have clicked the browse button [...] to the right of the FrDte field in 

the IP Service Node panel to open the Browse FrDte/Remote Group 
dialog box

Procedure steps
1 The Browse FrDte/Remote Group dialog box, is populated with a list of 

FrDte instances that are on the IP Service Node.

2 If only a FrDte is desired, select an instance from the FrDte Instance list, 
and click OK to populate the FrDte field in the IP Service Node panel with 
the selected FrDte instance.

If both a FrDte instance and media are desired, proceed to step 3.

3 Select the FrDte instance from the FrDte Instance list and click Show to 
retrieve a list of remoteGroup instances. They are listed in the RG List.

4 Select an entry from the RG List.

5 Click OK to populate the FrDte and Remote Group fields in the IP 
Service Node panel with the selected FrDte instance and Remote Group.
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Launching Embedded Nodal Provisioning
After provisioning a circuit, you can launch Embedded Nodal Provisioning 
(ENP) from the Frame Relay service provisioning tool, in context of the 
Interface or Logical Interface which you have created. This enables you to 
edit the interface.

Prerequisites
• you have successfully applied the provisioning and the Logical Interface 

or Interface component has been created. Clearing or changing the 
Logical Interface field after a successful apply will disable the launch 
point.

Procedure steps
1 Use one of the following methods to start Embedded Nodal Provisioning 

from the Frame Relay service provisioning tool:

• From the Edit menu, select Edit Interface.

• In the IP Service Node Properties panel, right-click the Interface or 
Logical Interface field to open a pop-up menu. From the pop-up 
menu, select Edit Interface.
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Frame Relay PVC provisioning

This section provides procedures to provision a Frame Relay permanent 
virtual circuit (PVC) user-to-network interface or network-to-network 
interface between two or more nodes. See the following sections:

• “Prerequisites” (page 115)

• “Provisioning a Frame Relay PVC path” (page 116)

• “Backup slaves configuration” (page 119)

— “Adding a backup slave” (page 120)

— “Editing a backup slave” (page 121)

— “Deleting a backup slave” (page 122)

Prerequisites
• the nodes to be provisioned are configured for Frame Relay up to the 

logical connection layer. For more information, see “Network element 
configuration” (page 21).
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 Provisioning a Frame Relay PVC path
Use this procedure to provision a Frame Relay permanent virtual circuit 
(PVC) path. If the Preside Multiservice Data Manager (MDM) 
Administration Database is installed, completing this procedure stores the 
following information in the database:

• circuit ID

• customer name

• TM profile

• source and destination nodes

• frunis or frnnis, depending on settings for master and slave instance type

• port identifiers

• DNA values

• DLCIs

• multiple slave backups, if backups are added

Prerequisites
• you are familiar with the Frame Relay service provisioning tool 

interface. See “Frame Relay service provisioning tool user interface” 
(page 29).

• you have read the section “General procedures” (page 71) describing 
general procedures for using the Frame Relay service provisioning tool

• you have started the Frame Relay service provisioning tool. See “Frame 
Relay service provisioning tool launch points” (page 73).

• if the Administration Database is installed, you have logged into the 
database

Procedure steps
1 On the File menu, click New Circuit….

2 Ensure that Circuit Type is FR PVC.

3 On the Options menu, click Set Default Authentication... to set the 
default login to connect to the nodes:

The Set Default Authentication dialog box opens.
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4 In the Set Default Authentication dialog box, type a user ID and 
password and click OK.

5 From the TM Profile list, select a profile in the TM Profile to be used in the 
Frame Relay PVC.

Note:  To create or edit a TM, see “Creating a new Traffic Management 
profile” (page 93), or “Editing a Traffic Management profile” (page 94).

6 In the Correlation Tag field, type a correlationTag. If you have installed 
the Administration Database you can select the Use Circuit Id option to 
set the value of the correlationTag to the value of the circuit ID. The 
correlation tag is only 32 bytes, so if you use the circuit ID, you need to 
limit the allowed 128 byte circuit ID to 32 bytes. If you have selected Use 
Circuit Id and more than 32 characters are entered in the Circuit Id field, 
the correlation tag on the node is set to the first 32 characters.

7 If you have installed the Administration Database, also complete the 
following fields:

• In the Circuit ID field, type a circuit ID number. The maximum length 
of a circuit ID is 32 characters.

• In the Correlation Tag field, type a correlationTag, or 

• In the Customer field, enter a customer name or click the browse [...] 
button to select a customer.

8 In the Master panel, provide a value in the Node Name field by one of the 
following methods:

• type a node name

• select a node name from the drop-down list

• click the browse […] button and use the Browse Nodes dialog box to 
search for and select a node. See “Browsing nodes” (page 83).

9 Provide a value in the User Id and Password fields by one of the 
following methods:

• Clear the Use Defaults check box and type a user ID and password.

• Select the Use Defaults check box to use the default user ID and 
password. 

10 In the Type field drop-down list, select the desired type of Frame Relay 
service: user-to-network (FR UNI) or network-to-network (FR NNI).

11 In the Fruni | Frnni Instance field, select either Fruni, data network 
address (DNA) or port interface and provide a value by one of the 
following methods:
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• Enter the value.

• Click Browse to select from a list. For more information, see 
“Browsing service interfaces” (page 84).

12 In the Slave panel Repeat steps 8-11in the Slave Node panel.

• If required, click the Use as backup check box to configure the slave 
node as a permanent backup slave. This check box is available only 
if backups exist. Otherwise, the check box is unavailable and the 
slave node is configured as a permanent slave with backups.

• Repeat steps step 8 tostep 11

13 To create a backup for the Frame Relay connection, click Edit Backup in 
the Slave Node area.

See “Edit Backup Slave dialog box” (page 62) for more information.

14 When you have entered all of the required information, click Apply... to 
open the Create Circuit dialog box. See “Applying the service creation” 
(page 97).

If you have not filled in all the mandatory fields, or have entered incorrect 
information, a message dialog opens identifying the missing information, 
or errors. Enter or correct the information, and click Apply... again.
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Backup slaves configuration
This section provides procedures to create or edit a backup slave node. See 
the following:

• “Adding a backup slave” (page 120)

• “Editing a backup slave” (page 121)

• “Deleting a backup slave” (page 122)
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Adding a backup slave
You can add a maximum number of seven backup slaves to a permanent 
virtual circuit path.

Prerequisites
• you have launched the Frame Relay service provisioning tool and the 

Service Provisioning - Frame Relay window is open

Procedure steps
1 Click Edit Backup in the Service Provisioning - Frame Relay window.

The Edit Backup Slave dialog box opens.

2 Complete all the fields in the Backup Slave area.

3 Click Add to save the backup slave. 

The backup slave appears in the Backup Slaves table.
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Editing a backup slave
You can edit the backup slave. 

Prerequisites
• you have launched the Frame Relay service provisioning tool and the 

Service Provisioning - Frame Relay window is open

Procedure steps
1 Click Edit Backup in the main window.

The Edit Backup Slave dialog box opens.

2 Select a backup slave in the Backup Slaves table.

3 Edit the fields as needed.

4 To save the changes without dismissing the dialog, click Add.

5 To save the changes and dismiss the dialog, click OK.
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Deleting a backup slave
You can delete a backup slave. 

Prerequisites
• you have launched the Frame Relay service provisioning tool and the 

Service Provisioning - Frame Relay window is open

Procedure steps
1 Click Edit Backup in the Service Provisioning - Frame Relay window.

The Edit Backup Slave dialog box opens.

2 Select the backup slave in the Backup Slaves table.

3 Click Delete.
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Chapter 6
Frame Relay circuits with IP access for 2547 
VPNs

This section describes how to create a Frame Relay (FR) circuit with Internet 
Protocol (IP) access for a 2547 IP Virtual Private Network (VPN). The Frame 
Relay service provisioning tool achieves this by creating Frame Relay access 
to a Virtual Router component. This enables a frame relay circuit to connect 
to an IP VPN. The tool supports the following types of access circuits for 
2547 VPNs:

• IP Optimized Backhaul

•  IP Optimized Local

Configuring the Frame Relay IP access circuits involves identifying the type 
of access circuit, connecting the IP access to the master side of the Frame 
Relay circuit, and then connecting the master side to the slave side of the 
circuit.

For more information, see the following sections

• “Prerequisites for provisioning Frame Relay circuits with IP access for 
2547 VPNs” (page 124)

• “Configuring circuit properties” (page 125)

• “Configuring IP Access for a 2547 VPN” (page 127)

• “Configuring Frame Relay Access node properties” (page 129)

• “Configuring end points” (page 130)
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Prerequisites for provisioning Frame Relay circuits with IP 
access for 2547 VPNs

• all the nodes to be provisioned have a FrUni or FrNni on the slave and a 
FrUni or FrNni, and Virtual Routing Function (VRF) on the IP Service 
node

• physical installation of cards, cabling, and other elements needed to 
interconnect the nodes for End-to-End provisioning

• provisioning of cards, logical processors, software, ports, Fruni or Frnni 
components

• Preside Multiservice Data Manager (MDM) Administration Database is 
installed

Network elements to be provisioned are configured for Frame Relay up to the 
logical connection layer.
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Configuring circuit properties
Use this procedure to provide circuit identifiers and to select the circuit 
configuration for Frame Relay IP VPN access.

Prerequisites
• You are familiar with the Frame Relay service provisioning tool user 

interface. For information on the user interface, see “Frame Relay service 
provisioning tool user interface” (page 29).

• You have launched the Frame Relay service provisioning tool

• You have logged into the database

Procedure steps
1 From the Circuit Type list in the Frame Relay service provisioning tool 

window, select FR IP VPN Access.

The Circuit Configuration list appears to the right of the Circuit Type 
list.

2 From the Circuit Configuration list, select the type of 2547 IP VPN circuit 
you wish to create:

• IP Optimized Backhaul

• IP Optimized Local

Based on the selected circuit configuration, the Site Type field displays a 
value of Intranet, Extranet, or Unknown.

3 Choose a Customer.

• For a new customer, in the Customer field, type a unique name for 
the new customer.

• To select an existing customer, click the browse button [...] to the right 
of the Customer field to open the Browse Customer dialog box. 
See the procedure “Browsing customers” (page 80). You can search 
for and select a customer from the available customers in the 
Administration Database. If you do not specify a customer, the 
default customer is used when the circuit is created.

4 Choose a Site.

• For a new site, in the Site field, type a unique name for the site. 

• To select an existing Site, click the browse button [...] to the right of 
the Site field, to open the Site Search dialog box. See the procedure 
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“Browsing Sites” (page 106).This dialog box lets you search for and 
select a site from the Administration Database. The Site must be 
unique for the Customer. If you select a site that does not have the 
same customer in the customer field, you will be prompted to 
synchronize them by changing the customer to that of the Site’s 
customer. Click Yes to synchronize them.

5 Choose an access point

• In the Access Point field, type an Access Point. This field must be 
unique within the Site.

6 Optionally, if you wish to provide descriptions of the Site and/or the 
Access Point, you can do this through the Administration Database tool.

Application main window -> Administration-> MDM Administration 
Database

7 Enter descriptions for the site and Access Point. For procedures relating 
to managing customer and site data, see 241-6001-400 Preside MDM 
Administration Database User Guide.

8 Proceed to “Configuring IP Access for a 2547 VPN” (page 127).
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Configuring IP Access for a 2547 VPN
Use the IP Service Node Properties panel to configure the IP service node. 
You provide input which is required to link the FR PVC to a VPN circuit. The 
IP Service Node is where the 2547 VRF, Media, Interface, and IP Service 
(master) FrUni/FrNni is located for Frame Relay IP VPN Access circuits.

Prerequisites
• the Virtual Routing Function (VRF) must already exist on the device

• You have completed the procedure “Configuring circuit properties” 
(page 125)

Procedure steps
1 Select an IP Service Node from the Node Name list, or click the browse 

button (...) to open the Browse Nodes dialog box. This dialog box allows 
you to specify search criteria and select a node. For the procedure to 
browse nodes, see “Browsing nodes” (page 83).

2 Optionally, deselect the Use Defaults check box to override the default 
login, and in the User Id and Password fields, type a user ID and 
password.

3 Click the browse button [...] to the right of the VRF field to open the 
Browse VR dialog box. 

4 If you have not already logged into the node, the Set Default 
Authentication dialog box opens.

5 Type in a User Id and Password, and click OK.

The Browse VR dialog box opens with a list of VRFs on the IP Service 
Node. 

6 Select a VRF from the list of available VRFs and click OK. See the 
procedure “Browsing VRs and VRFs” (page 107).

7 Select an interface address. The address must be unique within the VRF 
for each circuit. In the Interface field, type an interface address in the form 
of <ip_address>/<network_mask> where ip_address is an IP Address 
and mask number of consecutive 1’s in the mask.

8 For optimized backhaul circuit only, choose a service interface. The only 
available service type is FrUni. See “Browsing service interfaces” 
(page 84).
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9 Proceed to “Configuring Frame Relay Access node properties” 
(page 129)
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Configuring Frame Relay Access node properties
Configure the Frame Relay Access node properties panel. For the backhaul 
circuit configurations, the Node Name, browse nodes button [...], and default 
login fields are enabled. For the local circuit configuration they are disabled 
since the node is the same as the IP Service Node.

Prerequisites
• You have completed the following procedures:

— “Configuring circuit properties” (page 125)

— “Configuring IP Access for a 2547 VPN” (page 127)

Procedure steps
1 If configuring a backhaul circuit configuration, select a Node Name or click 

browse button to open the Browse Nodes dialog box. See the procedure 
“Browsing nodes” (page 83).

2 Select a service interface. From the Service Type list, select the type of 
Frame Relay service.
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Configuring end points
You can configure the end points for each end of the frame relay circuit 
through the End Points table.

Prerequisites
• you have decided on the CoS index(s) to be provisioned

Procedure steps
1 Fill in the relevant columns.

• for the IP Optimized Backhaul circuit configuration, fill in the Media 
DLCI column with the FrConn, the IP Service DLCI, and the FR 
Access DLCI columns. You can retrieve the unused FrConn by right-
clicking the cell an selecting Browse Frconn.

• for the IP Optimized Local circuit configuration, fill in the Media DLCI 
column with the FrConn and the FR Access DLCI column. You can 
retrieve unused FrConn by right-clicking the cell and selecting 
Browse DLCI.

You can right click in each of these columns and select the Browse DLCIs 
command to retrieve a list of available DLCIs. See the procedure 
“Browsing DLCIs” (page 108).

2 Optionally enter the correlation tag in the Correlation Tag column.

3 Click the TM Profile cell, and select a profile from the drop down list of 
available profiles.

4 Repeat these steps for each index to be provisioned.

5 Click Apply... to apply the provisioning. See the procedure “Applying the 
service creation” (page 97).

If a row in a table has some or all of the columns filled in, Frame Relay 
service provisioning will try to add the information under the given index. 
An error will occur if some information is missing from a partially 
completed row.
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Frame Relay circuits with IP access for 2764 
VPNs

This section describes how to create a Frame Relay (FR) circuit to an Internet 
Protocol (IP) access for a 2764 IP VPN. The Frame Relay service 
provisioning tool achieves this by creating Frame Relay access to a Virtual 
Router component. This enables a frame relay circuit to connect to an IP 
VPN. The tool supports the following types of access circuits for 2764 VPNs:

• IP Optimized Backhaul

• IP Optimized Local

• FrDte Backhaul

• FrDte Direct

The tool will provision the node when you apply the provisioning. The 
circuits are available with, or without being connected to the database. 
However, if you are connected to the Preside Multiservice Data Manager 
(MDM) Administration Database, the tool will populate the database with the 
information and components for these circuits when you apply the 
provisioning. 

Configuring the Frame Relay IP access circuits involves identifying the type 
of access circuit, connecting the IP access to the master side of the Frame 
Relay circuit, and then connecting the master side to the slave side of the 
circuit.
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For more information, see the following sections

• “Prerequisites for provisioning Frame Relay circuits with IP access for 
2764 VPNs” (page 132)

• “Configuring circuit properties” (page 133)

• “Configuring IP Access for 2764 VPN” (page 135)

• “Configuring Frame Relay Access node properties” (page 137)

Prerequisites for provisioning Frame Relay circuits with IP 
access for 2764 VPNs

• all the nodes to be provisioned have a FrUni or FrNni on the slave and a 
FrUni or FrNni, a FrDte, and VR on the IP Service node

• physical installation of cards, cabling, and other elements needed to 
interconnect the nodes for End-to-End provisioning

• provisioning of cards, logical processors, software, ports, Fruni or Frnni 
components

• Preside Multiservice Data Manager (MDM) Administration Database is 
installed

• Network elements to be provisioned are configured for Frame Relay up 
to the logical connection layer. 
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Configuring circuit properties
Use this procedure to provide circuit identifiers and to select the circuit 
configuration for Frame Relay IP VPN access.

Prerequisites
• You are familiar with the Frame Relay service provisioning tool user 

interface. For information on the user interface, see “Frame Relay service 
provisioning tool user interface” (page 29).

• You have launched the Frame Relay service provisioning tool

• You have logged into the Administration Database

Procedure steps
1 From the Circuit Type list in the Frame Relay service provisioning tool 

window, select FR IP VPN Access.

The Circuit Configuration list appears to the right of the Circuit Type 
list.

2 From the Circuit Configuration list, select one of the following types of 
access circuits: 

• 2764 IP Opt Backhaul

• 2764 IP Opt Local

• 2764 FrDte Backhaul

• 2764 FrDte Direct

The Site Type field displays a value of Intranet.

3 Choose a customer

• For a new customer, in the Customer field, type a unique name for 
the new customer.

• To select an existing customer, select a customer from the drop-down 
menu or click the browse button [...] to the right of the Customer field 
to open the Browse Customer dialog box. See the procedure 
“Browsing customers” (page 80). You can search for and select a 
customer from the available customers in the Administration 
Database. If you do not specify a customer, the default customer is 
used when the circuit is created.

4 Choose a Site.
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• For a new site, in the Site field, type a unique name for the site. 

• To select an existing Site, click the browse button [...] to the right of 
the Site field, to open the Site Search dialog box. See the procedure 
“Browsing Sites” (page 106).This dialog box lets you search for and 
select a site from the Administration Database. The Site must be 
unique for the Customer. If you select a site that does not have the 
same customer in the customer field, you will be prompted to 
synchronize them by changing the customer to that of the Site’s 
customer. Click Yes to sychronize them.

• In the Access Point field, type an Access Point. This field must be 
unique within the Site.

5 Optionally, if you wish to provide descriptions of the Site and/or the 
Access Point, you can do this through the Administration Database tool.

Application main window -> Administration-> MDM Administration 
Database

6 Enter descriptions for the site and Access Point. For the procedure to 
enter a site or access point description, see 241-6001-400 Preside MDM 
Administration Database User Guide.

7 Proceed to “Configuring IP Access for 2764 VPN” (page 135).
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Configuring IP Access for 2764 VPN
Use the IP Service Node Properties panel to configure the IP service node. 
This procedure links the FR PVC to a VPN circuit. The IP Service Node is 
where the 2764 VR, FrDte, Media, Logical Interface, and IP Service (master) 
FrUni/FrNni is located for FR IP VPN Access circuits.

Note: The data fields that appear in the Frame Relay service provisioning 
interface are determined by the circuit configuration. 

Prerequisites
• the VR must already exist on the device

• You have completed the procedure “Configuring circuit properties” 
(page 133)

Procedure steps
1 Select an IP Service Node from the Node Name list, or click the browse 

button (...) to open the Browse Nodes dialog box. This dialog box allows 
you to specify search criteria and select a node. For the procedure to 
browse nodes, see “Browsing nodes” (page 83).

2 Optionally, deselect the Use Defaults check box to override the default 
login, and in the User Id and Password fields, type a user ID and 
password.

3 Click the browse button [...] to the right of the VR field to open the Browse 
VR dialog box. 

4 If you have not already logged into the node, the Set Default 
Authentication dialog box opens.

5 Type in a User Id and Password, and click OK.

The Browse VR dialog box opens with a list of VRs on the IP Service 
Node. 

6 Select a VR from the list of available VRs and click OK. See the procedure 
“Browsing VRs and VRFs” (page 107).

7 In the Logical Interface (2764) field, type an interface address. The 
interface address is in the form of <ip_address>/<network_mask> where 
ip_address is an IP Address and mask number of consecutive 1’s in the 
mask.
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8 For 2764 FrDte Direct or 2764 FrDte Backhaul circuit configurations only, 
select the FrDte. In the FrDte field, type the instance number of the target 
FrDte, or click the browse button [...] to open the Browse FrDte/Remote 
Group dialog box. This dialog box lets you select either a FrDte or 
remoteGroup instance, or both. See the procedure “Browsing FrDte and 
Remote Group instances for 2764 FrDte circuits” (page 113).

When you apply the provisioning, a StaticDlci is provisioned and the 
media remoteGroup is created under the FrDte.

9 Choose the media. It can be an existing media or new:

• For FrDte circuit configurations, the media is Remote Group. You can 
type a Remote Group in the RemoteGroup field, or select it as part of 
the browse FrDte procedure. See step 8.

• For the IP Optimized circuit configurations, enter an instance in the 
lpDlciGroup field, or click the browse button [...] to browse available 
lpDlciGroups and select one from the list. See the procedure 
“Browsing lpDlciGroup instances for 2764 IP Optimized circuits” 
(page 112).

10 Choose an interface address. The address must be unique within the VR 
for each circuit. 

• In the Logical Interface field, type an interface address in the form 
of <ip_address>/<network_mask> where ip_address is an IP 
Address and mask number of consecutive 1’s in the mask.

11 For optimized backhaul circuit only, choose a service interface. The only 
available service type is FrUni. See “Browsing service interfaces” 
(page 84).

12 Proceed to “Configuring Frame Relay Access node properties” 
(page 137)
241-6001-603   15.1RSUP   



Chapter 7 Frame Relay circuits with IP access for 2764 VPNs   137
Configuring Frame Relay Access node properties
Configure the Frame Relay Access node properties panel. For the backhaul 
circuit configurations, the Node Name, browse nodes button [...], and default 
login fields are enabled. For the local circuit configuration they are disabled 
since the node is the same as the IP Service Node.

Prerequisites
• You have completed the following procedures:

— “Configuring circuit properties” (page 133)

— “Configuring IP Access for 2764 VPN” (page 135)

Procedure steps
1 If configuring a backhaul circuit configuration, select a Node Name or click 

browse button to open the Browse Nodes dialog box. See the procedure 
“Browsing nodes” (page 83).

2 Select a service interface. From the Service Type list, select the type of 
Frame Relay service.
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Configuring end points
You can configure the end points for each end of the Frame Relay circuit 
through the End Points table.

Prerequisites
• you have decided on the CoS index(s) to be provisioned

Procedure steps
1 Fill in the relevant columns.

• for FrDte circuit configurations, fill in the IP Service DLCI and FR 
Access DLCI columns. You can retrieve unused DLCIs by right-
clicking the cell and selecting Browse DLCI.

• for the IP Optimized Backhaul circuit configuration, fill in the Media 
DLCI column with the FrConn, the IP Service DLCI, and the FR 
Access DLCI columns. You can retrieve the unused FrConn by right-
clicking the cell an selecting Browse Frconn.

• for the IP Optimized Local circuit configuration, fill in the Media DLCI 
column with the FrConn and the FR Access DLCI column. You can 
retrieve unused FrConn by right-clicking the cell and selecting 
Browse DLCI.

2 Optionally enter the correlation tag in the Correlation Tag column.

3 Click the TM Profile cell, and select a profile from the drop down list of 
available profiles.

4 Repeat steps 1 to 3 for each index to be provisioned.

5 Click Apply... to apply the provisioning. See the procedure “Applying the 
service creation” (page 97).

If a row in a table has some or all of the columns filled in, Frame Relay 
service provisioning will try to add the information under the given index. 
An error will occur if some information is missing from a partially 
completed row.
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Frame Relay Real Time Log Display tool

This section explains the purpose of the Real Time Log File Display tool and 
describes how to use this tool. The RealTime Log Display tool lets you 
display and filter real time log messages generated by the Frame Relay 
service provisioning tool. Log messages may also be logged to a file.

See the following sections for more information:

• “Procedures” (page 140)

• “Real Time Log Display window” (page 150)

• “Menu shortcuts” (page 154)

Note: To view log files already logged to a file, use the Historic Frame 
Relay Log File Display tool, as described in “Historic Frame Relay Log 
File Display tool” (page 155).
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Procedures
See the following sections for procedures you can perform with the Real Time 
Log Display tool:

• “Starting the Real Time Log Display tool” (page 141)

• “Filtering log reports” (page 142)

• “Clearing the contents of a log report” (page 143)

• “Stopping incoming log messages” (page 144)

• “Deleting log files” (page 145)

• “Saving Real Time Log Display content” (page 146)

• “Printing Real Time Log Display content” (page 147)

• “Searching a word in the Real Time Log Display” (page 148)

• “Resizing a column” (page 149)

• “Hiding a column” (page 149)

• “Adding a column” (page 149)

• “Sorting a log report” (page 149)
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Starting the Real Time Log Display tool
You can start the Real Time Log Display tool from the View menu in the 
Frame Relay service provisioning main window.

Procedure steps
1 From the Service Provisioning - Frame Relay window, select View -> 

Show Messages....

The Real Time Log Display window opens.
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Filtering log reports
You can specify filtering criteria to display only a subset of the available log 
records.

Procedure steps
1 If required, start the Real Time Log Display tool.

2 From the Log Filter section, select the log level you wish to display by 
checking one or more of the following check boxes:

• Show All

• Critical

• Error

• Warning

• Info

• Verbose

• Command

3 Provision a frame relay permanent virtual circuit path between two nodes. 
See “Frame Relay PVC provisioning” (page 115).

4 If desired, click Refresh to display the Refresh dialog. If you do not click 
on the Refresh button, only new log records coming in will be filtered 
according to the new filtering criteria.

5 Specify the number of last log records, between 1 and all, that you want 
to filter with the new filtering criteria. 

6 Click OK.

The log report is cleared and previous and new log records are displayed 
according to the new filtering criteria.
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Clearing the contents of a log report
Procedure steps

1 From the Real Time Log Display window, click Clear.

The contents of the log report are erased.
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Stopping incoming log messages
You can temporarily stop the display of log records and then resume the 
display.

Procedure steps
1 From the Real Time Log Display window, click Pause.

New log records are no longer displayed.

2 To restart the display of new log records, click Resume.

Log records that were generated while the pause was on are not 
displayed.
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Deleting log files
Run the CleanLog script to delete log files after the specified retention period 
has expired. This script uses the log file’s last modification date to determine 
if the retention period has been reached or exceeded. In both cases, the log file 
is deleted. You can also schedule this script to run as a cron job.

Procedure steps
1 From the UNIX command line, type

/opt/MagellanMDM/bin/mdmcleanlog
[-keep | -k <day[s]>]
[-tool | -t <tool_name>]

where:

<tool_name> is the name of the tool that generates the log files. For 
Service Provisioning Frame Relay, specify sp_fr. The tool name is 
mandatory.

<day[s]> is the number of days from today for the log files that you do not 
want to be deleted. The default value is 30.
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Saving Real Time Log Display content
Procedure steps

1 From the File menu, select Save.

The Save dialog opens.

2 Enter a file name in the text field.

Note:  You can also change the file path. The default is /${HOME}/.

3 Click Save.
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Printing Real Time Log Display content
You can print a log report to a printer or a file.

Procedure steps
1 From the File menu, select Print.

The Print dialog box opens.

2 Complete the applicable information in the Print dialog box.

Note:  If you do not specify a printer, the default printer is used.

3 Click Print.
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Searching a word in the Real Time Log Display
Procedure steps

1 From the Edit menu, select Find.

The Find dialog box opens.

2 In the text field, enter the word you are looking for.

3 Click Find, as required.
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Resizing a column
1 Place the mouse at the right end of a column.

The mouse changes to a double-sided arrow.

2 Left-click the mouse and drag the column to the desired width.

Hiding a column
1 From the View menu, uncheck the column you wish to hide.

Adding a column
1 From the View menu, check the column you wish to add.

Note:  Any column added to the log report is added to the right side of the 
table.

Moving a column
1 Click on a column header.

2 Drag it and release it to the desired location.

Sorting a log report
1 To sort the log report in ascending order, click on a column header.

2 To sort the log report in descending order, click on a column header twice.
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Real Time Log Display window
 The Real Time Log Display window consists of menu bar, and two sections: 
Log Filter and Log Messages.

The window consists of the following elements:

• “Menu bar” (page 150)

• “Log filtering” (page 151)

• “Log messages” (page 152)

• “Buttons” (page 154)

• “Procedures” (page 140)

Menu bar
The menu bar consists of the following menu items:

• “File” (page 150)

• “Edit” (page 150)

• “View” (page 151)

• “Help” (page 151)

File
The File menu contains the following commands:

• Save displays a dialog that lets you save the content of the log report. The 
default path that the log report is saved in is ${HOME}/.

• Print displays a dialog that lets you print a log report or print it to a file. 
Clicking the print button displays the content of the log report. 

• Close closes the Real Time Log Display window.

Edit
The Edit menu contains the following commands:

• Clear empties the log report.

• Copy copies the selected log records into a buffer.

• Find displays a dialog that lets you do a key word search in the log 
report.
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• Select All selects all the contents of the log report.

View
The View menu contains check boxes that represent a column in the log 
report. These check boxes let you customize the log report by hiding or 
adding a column. The following columns are selected by default:

• Date

• Log Level

• Node Name

• Message

Note: Any column added to the log report is added to the right side of the 
table.

Help
The Help menu contains the following command:

• Help on Window displays on-line help information on the Real Time 
Log Display window.

Log filtering
You can filter logs from the Real Time Log Display window. This window 
contains check boxes consisting of the following levels:

• Show All filters logs on all levels.

• Critical indicates that an operation cannot be performed. This failure 
compromises the integrity of the process results. Processing may stop.

• Error indicates that an operation cannot be performed. This failure does 
not compromise the integrity of the process results. Processing 
continues.

• Warning indicates that an operation has completed without errors. The 
integrity of the process results are questionable.

• Info indicates there is an information message about the current process 
operation.

• Verbose indicates a verbose form of an information message.

• Command indicates a network element command.
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Click Refresh when you change the filtering criteria. If you do not click 
Refresh, only new log messages coming in will be filtered according to the 
new criteria.

Note: No matter what filtering criteria you choose, all log records are 
written to a file when the entry LogToFile=on in the Service 
Provisioning Frame Relay configuration file.

Log messages
The log messages section of the Real Time Log Display window contain 
columns for the date, log level, node name, and message. These columns are 
displayed by default.

You can customize the log report by resizing the columns or by hiding 
columns. You can also sort log reports by column heading, and scroll through 
the log list. When log records are logged to file, the field text box displays the 
log file name in which all log messages are written regardless of the log filter. 
The path of the file is displayed in a tool tip that displays when you put the 
mouse over that field.

 The log messages are logged in the directory /opt/MagellanNMS/data/log/
sp_fr/<user>/<display>, where:
<user> is your UNIX userid
<display> is the IP address or the hostname of the machine displaying the 
Real Time Log Display tool

Log files name
The name of a log file is the tool’s name and a timestamp of when the file was 
created. The format of a log file name is

<tool_name><YYYMMDD>T<HHMMSS>.log[nnn>[<nnn>]

where:
<tool_name> is the name of the tool that generates the log files. For Service 
Provisioning Frame Relay, the entry is sp_fr.

<nnn> is the value of the file counter. A three-digit counter is added to the 
rolled log file name when a log reaches its limit defined in the tool’s 
configuration file.
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An example of a log file is: sp_fr20011120T143244.log.001.

Log files header
To trace what was provisioned and by whom, a log file header is provided at 
the beginning of each log. The format of the log file header is

<FH><user>^\<host>^\<display>^\<file_name></FH>

where:
<FH> is the XML tag for file header

<user> is your UNIX userid

<host> is the host name that created the log file

<display> is the IP address or host name of the machine displaying the Real 
Time Log Display tool

An example of a log file header is: 
<FH>black^\wcars0nr^\47.123.45.678:0.0^\sp_fr20011120T143244.log.00
1</FH>

Log records format
Log records have the following format:

<LOG><timestamp>^\<log_level>^\<node_name>^\<message></LOG>

where:
<LOG> is the XML tag for a log record

<timestamp> is the date and time in the format: 
<YYYMMDD>T<HHMMSS>

<log_level> is the message’s priority level: critical, error, warning, info, 
verbose, command. See “Log filtering” (page 151) for definitions of the log 
levels.

An example of a log records format is: 
<LOG>20011101T152232^\COMMAND^\EM/ROME^\set fruni/6000 Dlci/
26 Dc ci 0.</LOG>.
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Buttons
The Real Time Log Display window consists of the following buttons:

• Pause/Resume is a toggle button that lets you stop and resume the 
display of new messages. When you click Pause, the label changes to 
Resume and vice versa. Pause stops new log messages from appearing 
in the viewer to help you analyze log messages without new messages 
coming in. Clicking Resume restarts the display of new log messages. 
The logged messages that were generated while Pause was on are not 
displayed when you click Resume.

• Refresh lets you apply new log filtering criteria against previous and 
new log records. When the Refresh dialog opens, it prompts you to 
specify how many previous log records you want to filter with the new 
criteria. The log report is cleared and the previous and new log records 
are displayed according to the new filtering criteria. 

When the refresh is finished, a dialog displays the amount of parsed log 
records. If the available amount of saved log records is less than what you 
requested, the dialog specifies that all log records have been parsed. The 
default value for the number of last records to be filtered is All. The 
allowable range is 1 to All.

Refresh is greyed out if the LogToFile entry is set to off in the Service 
Provisioning Frame Relay configuration file.

• Clear erases all the log records in the log report.

• Close closes the Real Time Log Display window.

Menu shortcuts
You can use the keyboard instead of the mouse to select a menu option. You 
can also execute a command by using a command accelerator.
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Historic Frame Relay Log File Display tool

This section explains the purpose of the Preside Multiservice Data Manager 
(MDM) Historic Frame Relay Log File Display tool and provides instructions 
for using the tool. This tool lets you view the content of historic log files based 
upon the filtering criteria that you specify. 

See the following sections for more information:

• “Historic Frame Relay Log File Display window” (page 155)

• “Using the keyboard commands” (page 162)

• “Procedures” (page 162)

Note: You can also view logs in real time using the Service Provisioning 
Frame Relay tool. For more information on the Real Time Log Display 
tool, see “Frame Relay Real Time Log Display tool” on page 139.

Historic Frame Relay Log File Display window
The Historic Frame Relay Log File Display window consists of a menu bar 
and three sections: Log Retrieval Criteria, Log Filtering Criteria, and Log 
Retrieval Results. The Log Retrieval Criteria and the Log Filtering 
Criteria sections are collapsible. 

The window consists of the following elements:

• “Menu bar” (page 156)

• “Log Retrieval Criteria” (page 158)

• “Log Filtering Criteria” (page 159)
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• “Log Retrieval Results” (page 161)

See the figure “Historic Log File Display window” (page 156).

Figure 2
Historic Log File Display window

Menu bar
The menu bar consists of the following menu items:

• “File” (page 157)

• “Edit” (page 157)

• “View” (page 157)
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• “Help” (page 158)

File
The File menu contains the following commands: 

• Save saves the log report to a file with the specified 
file name and location.

• Print displays a dialog. When you click Print, the log report is printed. 
to cancel the print job, click Cancel.

• Exit closes the Historic Log File Display window.

Edit
The Edit menu contains the following commands: 

• Clear empties the log report.

• Copy copies the current selection of the log report into the buffer.

• Find displays a dialog that lets you do a key word search in the log 
report.

• Select All selects all log report’s text.

View
The View menu contains the following commands:

• Log Retrieval Criteria
When you check this box, the Log Retrieval Criteria section 
uncollapses.

• Filtering Criteria
When you check this box, the Log Filtering Criteria section 
uncollapses.

• Report Columns 
This sub menu contains check boxes that let you customize your report 
by choosing which log record’s fields are shown or hidden. These fields 
are

— Date

— Log Level

— Node Name
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— Message

Help
The Help menu contains the following command: 

• Help on Window displays online help information on the Historic Log 
File window.

Log Retrieval Criteria
You use the Log Retrieval Criteria section to specify which logs file you 
wish to use to generate the log report. You can collapse this section by one of 
the following methods:

• From the View menu unselect Log Retrieval Criteria. 

• Click the arrow at the left end of the header section.

When you collapse this section, the free space is used by the Log Retrieval 
Results section. 

When you launch the tool, the User, Display and Log File fields contain 
asterisks. You can click Search to do a search for all log directories and all 
files. You can also refine your search by entering values and/or asterisks in 
the User, Display and Log File fields. The tool searches in the directory /opt/
MagellanNMS/data/log/<tool_name>/<user>/<display>/.

The search results are displayed in the Log Files scroll table. You must do a 
log file selection. You can do multi selections.

Log Source
The Log Source combo box contains the entry Service Provisioning Frame 
Relay. You need to select the tool name so that related log files for the tool are 
used when a log file search is performed.

Log Files
The Log Files section contains the columns: User, Display and Log File. Use 
the User and Display fields to enter directory names. You can also use wild 
cards. Use the Log File field to enter a log file name. You can also use wild 
cards on all these fields. Validation of these field values occurs when you 
click Search.
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You must select log files to use to generate the log report. The Log Files table 
is populated through the search based on the Log Source selected, and on the 
criteria you enter in the User, Display and Log File fields. You can change 
the log files you have selected. 

Search button
You can search for the retrieval of log files based upon the Log Source 
selected, and the User, Display and Log File fields.

Log Filtering Criteria
Use the Log Filtering Criteria section to define the filter you want to use to 
parse the log files selected in the Log Retrieval section. You can save and 
reuse filters. When you launch the Historic Log File Display tool, the filter’s 
file is parsed and the Filters List is populated. The default filter name is 
provided. This filter sets the Log Level to Show All. The default filter is 
always selected when you launch the tool. You can also modify and save the 
default filter, but you cannot delete it.

Filter List
The Filter List is an editable combo box that contains the saved filters and 
the default filter when you launch the Historic Log File Display tool. You can 
select a filter from the combo box. You can also enter a new filter’s name in 
the combo box field to save a filter or to use it without saving it.

Log Levels
The log level attribute is the only mandatory attribute when you create a filter. 
You can choose the log level you want to be shown in the log report by 
clicking the appropriate check box. There are four levels of filtering logs:

• Show All selects all log levels. Show All is the default value when you 
launch the Historic Log Display tool.

• Critical indicates that an operation cannot be performed. This failure 
compromises the integrity of the process results. Processing may stop.

• Error indicates that an operation cannot be performed. This failure does 
not compromise the integrity of the process results. Processing 
continues.

• Warning indicates that an operation has completed without errors. The 
integrity of the process results are questionable.
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• Info indicates that there is an information message about the current 
process operation.

• Verbose indicates a verbose form of an information message.

• Command indicates a Passport command.

Msg Key Words
Enter key words that you want to be present in all log messages in the Msg 
Key Words field. By default, only log messages that include all searched 
terms are selected. Do not include “and” or “AND” between the terms. This 
word is not considered a logical word, and is treated as any other word. Msg 
Key Words are not case sensitive.

Node Name
The Node Name field populates the Nodes List.

Nodes List
The nodes in the Nodes List are used as the filtering criteria. Only the log 
records related to those nodes are displayed in the log report. The list is 
populated by using the Node Name field.

Max Records
You can specify the maximum number of log records to include in the log 
report in the Max Records combo box. You can enter a value or choose a 
predefined one. The default is to include all log records when left empty.

Display Count Only
The Display Count Only checkbox lets you prevent the display of log 
records in the log report. Only the number of log records found from the 
search is displayed by Records Found in the status area.

Save button
Save lets you save the current filter criteria with the filter’s name displayed 
in the filter name field. All filters are saved in the file $<HOME>/
MagellanNMS/LogFilters.cfg, where $<HOME> is your home directory.

Delete button
Delete lets you delete the current filter.
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Reset button
Reset reloads the filter with the last saved attribute values.

Retrieve button
Retrieve lets you start the log records retrieval to generate the log report in 
the Log Retrieval Results section. If you do not specify a filter name in the 
filter list when the Retrieve button is pressed, a dialog opens. The dialog 
prompts you to continue without using a filter to parse the selected log files.

Log Retrieval Results
The Log Retrieval Results section consists of the following:

• Log Report Table

• Status area

• File Header Information field

Log Report Table
The Log Report Table displays the log records that meet the Log Retrieval 
Criteria and Log Filtering Criteria. You can scroll through the table, which 
contains the following columns;

• Date

• Log Level

• Node Name

• Message

You can customize your Log Report by resizing, hiding or reordering the 
columns. You can also use the column heading to sort the report. All columns 
are displayed by default.

Status area
The status area shows the number of records found.

File Header Information Field
The File Header Information field shows the corresponding file header of a 
log record when you click on a log record in the Log Report Table.
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Using the keyboard commands
For the Historic Log File Display tool, you can use the keyboard instead of 
the mouse to select a menu option. You can also execute a command by using 
a command accelerator. See the following sections:

• “Mnemonics” (page 162)

• “Command accelerators” (page 162)

Mnemonics
Every menu option in the menu bar has a mnemonic associated with it. Each 
mnemonics usually consists of the Alt key followed by the first letter of the 
menu and the first letter of the menu option. 

Example: To print the log report using mnemonics, press the Alt key plus the 
letter F and then the letter P.

The single character that selects a given menu option is shown by the 
underscore in the name of the menu’s active name. If there are duplicate 
options in the same menu, the second capital letter is used. If there are 
duplicates and no other capital letters in the menu option, the second letter is 
used.

Command accelerators
The Historic Log File Display tool provides command accelerators to execute 
menu commands. Each accelerator usually consists of the control key 
followed by the first letter of the menu option. The command accelerator is 
shown beside each menu option.

Example: To save a log report using a command accelerator, press the 
Control key plus the letter S.

Procedures
See the following sections for procedures you can perform with the Historic 
Log File Display tool:

• “Starting the Historic Log File Display tool” (page 163)

• “Selecting log files” (page 163)

• “Creating a filter” (page 164)
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• “Saving a filter” (page 164)

• “Deleting a filter” (page 165)

• “Resetting the filter’s criteria” (page 165)

• “Using the filter” (page 165)

• “Saving a log report” (page 165)

• “In the File name field, enter a file name.” (page 165)

• “Printing the log report” (page 165)

• “Searching for a word in the log report” (page 166)

• “Resizing a column” (page 166)

• “Hiding a column” (page 166)

• “Sorting a log report” (page 167)

Starting the Historic Log File Display tool
1 You can start the Historic Log File Display tool by one of the following 

methods:

• From the application main window select Configuration -> Passport 
-> Administration-> Historic Frame Relay Log File Display.

• From a UNIX shell, enter the command /opt/MagellanNMS/bin/
historicLogDisplay.

The Historic Log File Display window opens.

Selecting log files
1 From the Log Source combo box, ensure that the entry Service 

Provisioning Frame Relay is selected.

2 Enter a directory name or a wild card in the following fields:

• User

• Display

The directory name maps to the path /opt/MagellanNMS/data/log/<tool>/
<user>/<display>/ where:

<user> is your UNIX user ID
<display> is the IP address or the host name of the machine that is
displaying the Historic Log File Display application.
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<tool> is the tool name that you are running the Historic Log File
Display on. The only value for this is sp_fr for Service
Provisioning Frame Relay.

3 Enter the file name or a wild card in the Log Files field.

4 Click Search. You must have a value in the User, Display and Log File 
fields for the search to launch.

The log files contained in the paths are displayed in the scroll table. Select 
the files that you want to be filtered.

Note:  To select a group of files that appear consecutively in the listing, 
select the first one, and then select the last one while holding the shift 
key. If the logs do not appear consecutively, select the first one, and hold 
the Control key to select the others.

Creating a filter
The log level attribute is mandatory.

1 From the Historic Log File Display window, enter a filter name in the 
Filters List field.

2 Select the desired log level(s) by checking the required check boxes.

3 In the Node Name field, enter a node name, and press the return key to 
populate the Node List. Repeat this step, if necessary.

Note:  To remove an entry in the Nodes List, select the node, then press 
the delete key on your keyboard.

4 From the Max Records combo box, specify the maximum number of 
records you want to display in the Log Report. You can type one or select 
a predefined value.

5 To have only the number of log records that meet the filter criteria and not 
their content, check the Display Count Only box.

Saving a filter
1 From the Historic Log File Display window, enter the filter name in the 

Filter List combo box.

2 Set your filter attributes.

3 Click Save.

Note:  All filters are saved in the file /$<HOME>/MagellanNMS/
LogFilters.cfg, where $<HOME> is your home directory.
241-6001-603   15.1RSUP   



Chapter 9 Historic Frame Relay Log File Display tool   165
Deleting a filter
1 From the Historic Log File Display window, enter a filter name in the 

Filter List combo box. You can also select a filter from the Filter List 
combo box.

2 Click Delete.

Resetting the filter’s criteria
1 From the Historic Log File Display window, click Reset to reload the 

filter with the last saved values.

Using the filter
1 From the Historic Log File Display window, click Retrieve to generate 

the log report.

Saving a log report
1 From the File menu, select Save Report.

2 In the File name field, enter a file name.

Note:  You can also change the file path. The default path is ${HOME}/.

3 Click Save.

Printing the log report
1 From the File menu, select Print.

The Print dialog opens.
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By default, the printer that you set in your environment is set as the current 
printer. You can change the printer by writing its name in the Printer field.

2 Click Print.

Searching for a word in the log report
1 From the Edit menu, select Find.

The Find dialog opens. 

2 In the text field, enter the word you are searching for.

3 Click Find, as required.

Resizing a column
1 Place the mouse at the right end of a column. 

The mouse changes to a single-sided arrow.

2 Left-click the mouse and drag the column to the desired width.

Hiding a column
1 From the View menu, select Report Columns.

2 Uncheck the column you wish to hide.

Adding a column
1 From the View menu, select Report Columns.

2 Check the column you wish to add.

Moving a column
1 Click on a column header.

2 Drag it and release it to the desired location.
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Sorting a log report
1 To sort the log report in ascending order, click on a column header.
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